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Before you begin  Standard 1.0
Maintenance and diagnostics overview

Introduction

This guide provides information and instructions for maintaining the current 
functions of a CallPilot server, and for troubleshooting any problems that might 
arise.

Who should read this guide

This guide is for planners, administrators, technicians, and engineers responsible for 
maintaining a CallPilot server. It is intended to act as a guide for installing, repairing, 
replacing, and upgrading hardware and software components. It assumes that the 
reader has basic computing skills, is familiar with necessary safety procedures, and 
has the hardware documentation provided by the manufacturer available as a 
reference.

Assumptions

This guide assumes that you are planning to maintain or troubleshoot an existing 
CallPilot server.

Types of maintenance and diagnostic activities

The maintenance and diagnostic activities discussed in this guide are divided into 
three groups of activities:

■ troubleshooting and diagnostics (identifying the cause of and resolving system 
problems)

■ performing hardware maintenance 

■ expanding or rebuilding your system

Resolving system problems

Two sources of documentation are available for resolving system problems:

■ this guide

■ CallPilot Troubleshooting Reference

Using the CallPilot Troubleshooting Reference
The CallPilot Troubleshooting Reference describes symptoms that can appear on all 
CallPilot server platforms, and describes ways to resolve them. This document is 
continually being updated by Nortel Networks and is made available on the Nortel 
Networks Partner Business Center web site at 
http://www.nortelnetworks.com/partnercenter. 
12 CallPilot



October 2000            Before you begin
Note: If you are not a distributor, then contact your Nortel Networks technical 
support representative for assistance.

Use the CallPilot Troubleshooting Reference to resolve the following types of 
problems:

■ 201i server boot cycle failures

■ peripheral device problems

■ monitor display problems

■ server to network connection problems

■ remote access connection problems

■ CallPilot application problems

Using this guide
This guide provides instructions for using the resources provided by your 201i 
system. 

■ LEDs and HEX display on the 201i server’s faceplate (see “LED and HEX 
displays” on page 27 in Chapter 2)

■ bootup sequence and diagnostic codes (see “Bootup diagnostics” on page 35 in 
Chapter 2)

■ log files (see “Viewing installation and configuration log files” on page 49 in 
Chapter 2)

■ Windows NT 4.0 diagnostics and Event Viewer (see “Checking hardware using 
Windows NT 4.0 diagnostics” on page 53 in Chapter 2)

■ TCP/IP diagnostics (see “Invoking and interpreting TCP/IP diagnostics” on 
page 56 in Chapter 2)

■ Event Browser, Alarm Monitor, and Maintenance window in the CallPilot 
server software (see Chapter 3, “Using the administrative PC to diagnose the 
server”)

■ the following CallPilot system utilities:

■ Diagnostics Tool

■ PEP Maintenance utility

■ Services Monitor

■ Session Trace tool 

■ System Information tool

■ System Monitor

For more information, see Chapter 4, “Using CallPilot system utilities.”
Part 5: 201i Server Maintenance and Diagnostics 13
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Performing hardware maintenance

Chapter 5, “Performing hardware maintenance and mechanical assembly,” explains 
how to shut down the server, and then remove it from the switch in preparation for 
replacing one or more of the following hardware components:

■ MPC-8 cards

■ software feature key (dongle)

■ hard drive

This chapter also explains how to replace your 201i server in the event of complete 
system failure.

Expanding or rebuilding your system

When you purchased your 201i server, it came preinstalled with the Windows NT 
operating system and CallPilot server software. 

You might need to expand its functionality or, if your 201i server no longer functions 
because of corrupted software, you might need to reinstall the CallPilot software or 
rebuild the system from scratch. 

The following table identifies where to find information for the task you need:

Task For more information, see

Expand your system by adding features or configuring 
additional channels to CallPilot.

Note: CallPilot does not support feature reduction other 
than for channels that have been previously allocated.

Chapter 6, “Expanding 
CallPilot features.”

Reinstall the CallPilot server software.

If the hard drive is functioning but the CallPilot software 
appears to be corrupted, you can reinstall the CallPilot 
server software. This might correct the problem. 

“Recovering from corrupted 
software (hard drive is 
functioning)” on page 140 in 
Chapter 7.

Rebuild the system.

Perform a system rebuild when you need to recover from a 
hard drive failure. This involves the following tasks:

1 Boot to ROM-DOS and reformat the hard drive.

2 Install Windows NT Server 4.0.

3 Install Windows NT service packs.

4 Install pcANYWHERE32.

5 Install CallPilot server software.

6 Install Performance Enhancement Packages (PEPs).

Chapter 8, “Installing the 
operating system and server 
software.”
14 CallPilot
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Preparing for maintenance activities

Before you begin any maintenance activities, collect all the tools you need, and 
follow all recommended safety precautions.

This chapter discusses the tools and equipment required for performing maintenance 
procedures in the field. Recommended safety precautions for electrostatic discharge, 
handling cards, and handling your server are also included.

Uninstall the CallPilot server software.

Uninstallation of CallPilot removes the software 
completely from the server. It also removes all CallPilot 
registry entries, linguistic information, and all links to 
CallPilot from the server database.

Chapter 9, “Uninstalling 
CallPilot server software.”

Task For more information, see
Part 5: 201i Server Maintenance and Diagnostics 15
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Required tools and materials

Introduction

This section identifies the tools and materials you might need in addition to the 
approved replacement parts.

Tools and materials

Use this checklist for the tools and materials you might need to use to perform 
maintenance tasks.

Check Description

❒ Antistatic ESD wrist strap (recommended)

❒ Two Phillips cross-head screwdrivers (No. 1 and No. 2)

❒ Standard slot-head screwdriver (1/4" and 1/2")

❒ Sidecutters

❒ Jumper removal tool or needle-nosed pliers

❒ Tweezers

❒ Tape measure for determining cable lengths

❒ Pen for writing notes, cable lengths, and cable identifications

❒ Cable tie wraps

❒ Cable identification labels

❒ Equipment log

This is used to record the model and serial number of the system, all 
installed options, and other information.

❒ Null modem serial cable (it can be useful for troubleshooting)

❒ Laptop computer and CD-ROM drive (to read documentation on 
CD-ROM and to connect to the network on which the server is located 
for troubleshooting)
16 CallPilot
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Approved replacement parts

Before replacing any parts on your server, refer to the Enterprise Product catalog for 
the part codes.

. 

CAUTION

Risk of system damage
The use of non-approved replacement parts can cause serious 
system problems or void your Nortel Networks warranty.
Part 5: 201i Server Maintenance and Diagnostics 17
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General safety

Introduction

When installing, replacing, or upgrading any system parts, follow Nortel Networks 
safety guidelines to prevent personal injury and damage to the server or replacement 
parts.

Precautionary messages

This guide provides warnings when risks related to hardware installation and 
handling are known. Do not ignore these warnings. 

Note: For a description of the potential impact that the warnings in this guide might 
have if they are ignored, see “Symbols and conventions” in Part 1 of this binder.

General precautions

Nortel Networks recommends the following safety guidelines for performing 
installation and maintenance procedures:

■ Plug the peripheral devices only into properly grounded power sources to 
prevent electric shock.

■ Use a surge protector or uninterruptible power supply to protect your system 
from sudden increases and decreases in electrical power.

■ Ensure that nothing rests on peripheral cables, and that you cannot trip over or 
step on cables.

■ Do not push any foreign objects into any server opening.

■ When handling components, protect the server from electrostatic discharge by 
wearing an antistatic wrist strap attached to any unpainted metal surface on the 
switch.

. 

WARNING

Risk of personal injury and equipment damage
Field maintenance must always be performed by fully qualified, 
trained personnel.
18 CallPilot
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Avoiding electrostatic discharge

Introduction

Electrostatic discharge (ESD) can seriously damage component parts such as boards, 
disk drives, and other parts. 

Antistatic wrist strap

If an ESD workstation is not available, provide some ESD protection by wearing an 
antistatic wrist strap. Ground the ESD wrist strap by attaching it to any unpainted 
metal surface on the switch.

The following diagram shows the lead from the ESD wrist strap clipped to an 
exposed screw on a chassis. 

To discharge static

When working with server components, periodically touch a nearby unpainted metal 
surface to discharge any accumulated static.

ATTENTION
Nortel Networks recommends performing all hardware 
installation and maintenance procedures at an ESD 
workstation whenever possible.

G100733
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Precautions for handling components

These precautions are recommended for any procedure that includes handling 
component boards:

■ After removing a board from its protective wrapper or from the server, place the 
board component-side up on a conductive foam pad. 

If possible, use antistatic floor pads and workbench pads as well.

■ Do not slide a board over any surface.

■ Do not touch board components or gold-edge connectors on the board.

■ Hold a board by the top edge or by the side edges.
20 CallPilot
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Handling hard drives

Introduction

Hard drives are extremely sensitive to vibration and physical shock. To protect 
equipment and prolong the useful life of hard drives, Nortel Networks recommends 
the following precautions.

Avoid vibration or physical shock

Hard drives are susceptible to even slight vibrations. A hard drive can be damaged if 
it is placed on a table that is accidently knocked or moved. Use caution when 
handling hard drives to prevent damage.

Handle hard drives with care

After removing a hard drive from its protective wrapper or from the server, place it 
on an antistatic, padded workbench or workstation to avoid movement or jarring.

Check for shipping damage

If a replacement hard drive is shipped alone as an upgrade or replacement, note any 
dents or damage on the container and packaging. Keep the container as proof that the 
part was damaged during shipping and handling.

Precautions when removing the hard drive

Before you can remove the hard drive, you must perform a proper system shutdown, 
and then remove the 201i server from the switch. For detailed instructions, see 
Chapter 5, “Performing hardware maintenance and mechanical assembly.”

Store hard drives carefully

Store hard drives in padded containers. Store the packaged drives away from places 
where they can be moved, jarred, or damaged by the environment.
Part 5: 201i Server Maintenance and Diagnostics 21
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Handling CD-ROMs

Introduction

When removing a CD-ROM from its protective case or loading it to a drive, hold it 
by its center hole and outer edge. Avoid touching the CD-ROM’s data surface (the 
non-labeled side).

To protect the CD-ROM against scratches and dirt when not in use, keep it in its 
protective case.

To load a CD-ROM

1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Place the CD-ROM on the tray with its labeled side facing up.

3 Press the eject button or gently press the front of the disk tray to retract the tray 
back into the drive.

To eject a CD-ROM

1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Remove the CD-ROM from the tray and put it in its protective case.

3 Press the eject button or gently press the front of the disk tray to retract the tray 
back into the drive.
22 CallPilot
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Troubleshooting your CallPilot system  Standard 1.0
Overview

Introduction

This section provides a brief description of the tools you can use to determine the 
cause of system problems, and then resolve them.

Resolving system problems

Two sources of documentation are available for resolving system problems:

■ this guide

■ CallPilot Troubleshooting Reference

Using the CallPilot Troubleshooting Reference

The CallPilot Troubleshooting Reference describes symptoms that can appear on all 
CallPilot server platforms, and describes ways to resolve them. This document is 
continually being updated by Nortel Networks and is made available on the Nortel 
Networks Partner Business Center web site at 
http://www.nortelnetworks.com/partnercenter. 

Note: If you are not a distributor, then contact your Nortel Networks technical 
support representative for assistance.

Use this document to resolve the following types of problems:

■ 201i server boot cycle failures

■ peripheral device problems

■ monitor display problems

■ server to network connection problems

■ remote access connection problems

■ CallPilot application problems

Using this guide

This guide provides instructions for using the resources provided by your 201i 
system. 

LEDs and HEX display on the 201i server’s faceplate
The LEDs indicate when

■ the 201i server, MPC-8 card, or SCSI drive are in use

■ it is safe to remove the server from the switch, or the MPC-8 card from the 
server
24 CallPilot
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■ network activity is occurring

The HEX display displays messages that appear during bootup or normal 201i server 
operation.

For more information, see “LED and HEX displays” on page 27.

Bootup sequence and diagnostic codes
To help you determine if the 201i server booted successfully (or if it failed), watch 
the bootup sequence and the diagnostic codes that appear. The entire sequence 
occurs when you do one of the following:

■ Lock 201i into position on the IPE shelf or Option 11 and the 201i begins 
receiving power.

■ Restart Windows NT.

■ Press the 201i faceplate reset button to perform a hardware restart.

For more information, see “Bootup diagnostics” on page 35.

Log files
The installation event log tracks events associated with any install, reinstall, upgrade, 
or uninstallation operation. The log also tracks any fatal errors that interrupt these 
operations. 

The Configuration Wizard log file is a record of the information entered through the 
CallPilot Configuration Wizard.

For more information, see “Viewing installation and configuration log files” on page 
49.

Windows NT 4.0 diagnostics and Event Viewer 
The Windows NT 4.0 Diagnostics window allows you to view details concerning the 
system and network components. 

The Event Viewer provides access to three logs (system, security, and application), 
which you can use to diagnose and debug system problems.

For more information, see “Checking hardware using Windows NT 4.0 diagnostics” 
on page 53.

TCP/IP diagnostics
The following diagnostic tools help you verify network connectivity and routing:

■ ipconfig

■ ping

■ tracert
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■ arp

■ nbtstat

■ netstat

For more information, see “Invoking and interpreting TCP/IP diagnostics” on page 
56.

Event Browser, Alarm Monitor, and Maintenance window in the 
CallPilot server software
An event is 

■ any change in system configuration or operational state

■ any action taken by the system that requires user notification

An alarm is an event that notifies you of a potential or real problem. 

For more information, see Chapter 3, “Using the administrative PC to diagnose the 
server.”

CallPilot system utilities
The Diagnostics utility allows you to enable and disable CallPilot startup diagnostics 
to run when the system boots. This tool saves time during system maintenance 
operations where restarts or Call Processing services restarts are required.

The PEP Maintenance utility displays a list of all installed PEPs on the server and 
enables you to uninstall PEPS.

The Services Monitor can help you determine whether the CallPilot server is fully 
operational. It displays true states of the CallPilot services according to Windows 
NT definition, including the states that are not available through the control panel.

The Session Trace tool provides detailed information about the activity in a user’s 
mailbox and the state of the message waiting indicator (MWI). 

The System Information tool displays particulars about the CallPilot system, such as 
names, keycodes, serial numbers, IP addresses, and system numbers.

The System Monitor provides a single point of view of CallPilot call processing 
status at any time. The status provided reflects the true internal status of the Call 
Processing subsystem, including all related call processing components. This 
eliminates the need to use multiple tools to get the same information.

For more information, see Chapter 4, “Using CallPilot system utilities.”
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Section A: LED and HEX displays

In this section
Location of the 201i status LEDs and HEX display 28
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Location of the 201i status LEDs and HEX 
display

The following diagram shows the location of the status LEDs and HEX display on the 
201i server faceplate:

G101439

Power status LED

MPC status LEDs

HEX display

MPC status LEDs

Network and drive 
activity LEDs
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Interpreting the power status LED

Introduction

The power status LED is located on the faceplate of the 201i server, directly under 
the keyboard connector. The LED indicates whether it is safe to remove the server 
from the switch (which results in a server power down).

After the 201i server has been inserted into the switch and is powered up, it can be 
safely removed (powered down) only at certain times. 

Power status LED functions

The LED indicates two server states:

■ The 201i server is in use.

■ It is safe to remove the 201i server from the switch.

Power status LED indications

. WA

CAUTION

Risk of equipment damage or data loss
Do not remove the 201i server during normal operation or certain 
phases of the boot sequence as this can damage the operating system 
files on the hard disk.

IF the power status LED is THEN

on the server is powered on. It is safe to remove it from 
the switch.

Note: When the LED is lit, the HEX display might 
display one of the following: T:XX, F:XX, HOST, or 
DOWN.

off it is not safe to remove the server from the switch. 
The server is in one of the following states:

■ The server is in the Windows NT bootup 
sequence.

■ The server has completed the bootup sequence 
and is running.
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Interpreting the MPC slot LEDs

Introduction

There is an LED for each MPC slot on the 201i server.

MPC slot LED functions

The LEDs indicate two possible MPC slot states:

■ The MPC is in use.

■ It is safe to remove the MPC from the server.

MPC slot LED indications

IF the MPC slot LED THEN

is off the MPC is not receiving power. 

It is safe to remove the MPC from the server.

is on the MPC is in use. 

It is not safe to remove the MPC from the server.

was off, then came on the MPC was recognized by the 201i software and 
subsequently powered up.

was on, then went off the MPC was successfully powered down from the 
Maintenance window. 

It is safe to remove the MPC from the server.
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Interpreting the network and drive activity LEDs

Introduction

The 201i server provides four LEDs to indicate ELAN, CLAN, SCSI device, and 
IDE hard drive activity. They are labeled as follows:

Network LED states

Refer to the following table when interpreting network status:

LED label Description

E ELAN

C CLAN

I IDE hard drive

S SCSI device (CD-ROM or tape drive)

IF the E or C LEDs are THEN

off a valid hardware connection with the network has not 
been established. 

Ensure that the cable is connected to the respective 
network hub. If the cable is connected, ensure that the 
cable is good.

on a valid hardware connection with the network has been 
established. 

Note: Before the 201i server can receive or transmit 
data, you must configure valid IP settings on the 201i 
server.

blinking rapidly activity is occurring on the network. 

Note: This does not mean that the 201i server is 
actually transmitting or receiving packets. 
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IDE drive LED states

Refer to the following table when interpreting the IDE hard drive status:

SCSI device LED states

Refer to the following table when interpreting the external SCSI device status:

IF the I LED is THEN

off the IDE hard drive is idle.

on the IDE hard drive is being accessed.

IF the S LED is THEN

off the SCSI device is idle, or the driver is not loaded.

blinking the SCSI device is being accessed.

lit solid the software driver has loaded but the SCSI device is 
not connected.
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Interpreting the HEX display

Introduction

This section describes the codes that can appear on the HEX display during bootup 
or normal 201i server operation.

Note: For a description of the codes that appear during bootup diagnostics, see 
“Bootup diagnostic codes” on page 36. For a description of the bootup sequence, see 
“Bootup sequence description” on page 39.

HEX display codes

During bootup and normal 201i server operation, the HEX display on the server 
faceplate displays one of the following codes:

HEX display output Description

Boot sequence codes

T:XX The 8051 controller is booting up and running diagnostics. These 
diagnostics are performed during a cold reboot (when the server is 
powered up, or if you press the Reset button). 

For more details, see “Bootup diagnostic codes” on page 36.

F:XX At least one diagnostic failed. The displayed error code represents 
the first failed diagnostic.

For more details, see “Bootup diagnostic codes” on page 36.

P:XX An Extended POST error has occurred, where XX represents a 
two-character code. If the error is a critical error, the boot cycle 
might halt. If the error is a non-critical error, the error code is 
logged in the Windows NT system event log after the operating 
system boot completes and the CallPilot 8051 device driver starts.

ATTENTION 
POST Terminal errors that result in a system halt do not appear on 
the HEX display. If you are not able to use the HEX display to 
determine the cause of a system halt, contact your Nortel Networks 
technical support representative.

HOST This appears during the bootup sequence and means that BIOS 
diagnostics have started.

HOST also appears on the HEX display when the server has been 
booted to ROM-DOS.

NT The Windows NT boot sequence has started. 
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Note: If you observe “???” or anything else on the display, contact your Nortel 
Networks technical support representative.

OK The operating system boot sequence was successful.

CallPilot and 201i server operation codes

BOOT CallPilot is booting and is not yet fully operational. 

PASS CallPilot is fully operational and ready to accept calls.

WARN CallPilot is ready to accept calls. However, some services failed the 
boot sequence. Review the event log for further information. 

FAIL CallPilot failed the boot sequence and cannot accept calls. Review 
the event log for further information. 

MIN A minor alarm has occurred. Review the event log for further 
information. 

MAJ A major alarm has occurred. Review the event log for further 
information. 

CRI A critical alarm has occurred. Review the event log for further 
information. 

??? An alarm of unknown severity occurred. This error should not 
occur on a properly installed system. The severity of this event is 
treated as higher-than-critical.

DOWN Windows NT has been shut down. When the power status LED is 
on, it is safe to remove the 201i server from the switch.

If you perform a cold reset by pressing the reset button on the 201i 
server’s faceplate, or by removing and then reinserting the 201i 
server in the switch, the boot sequence starts at stage 1, described 
on page 39. 

If you perform a warm restart by selecting Restart on the Windows 
NT shutdown menu, the boot sequence starts at stage 9, described 
on page 40. However, the HEX display behaves as follows:

■ The DOWN message remains displayed until the Windows NT 
boot sequence starts.

■ The DOWN message does not scroll.

HEX display output Description
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Section B: Bootup diagnostics

In this section
Bootup diagnostic codes 36

Bootup sequence description 39
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Bootup diagnostic codes

Introduction

HEX display diagnostic codes are divided into the following two categories:

■ critical bootup diagnostics

■ noncritical operating system and switch diagnostics

Critical bootup diagnostic codes

All critical bootup diagnostics must pass before the 201i can proceed with the 
bootup sequence. If a critical diagnostic fails, the bootup sequence indefinitely halts, 
an error code displays, and a continuous beep is heard. 

The following table shows the critical bootup diagnostic codes with their 
corresponding failure codes. Failure of these diagnostics means that there has been a 
server failure. The boot cycle is halted.

Note: When a test is successfully completed, the next test code appears. 

Test code Test description Failure code

T:01 Internal RAM self-test F:01

T:02 ALU self-test F:02

T:03 Address mode self-test F:03

T:04 Boot ROM self-test F:04

T:05 Timer self-test F:05

T:06 Watchdog self-test F:06

T:07 EEPROM self-test F:07

T:08 End of system controller self-tests

The power status LED blinks three times.

not applicable

HOST Beginning of BIOS diagnostics

The monitor displays the BIOS boot screen. 

If a critical error occurs, the boot cycle is 
halted. Examples of critical errors are memory 
failure or another type of error resulting in no 
display on the monitor.

HOST continues to 
scroll across the 
HEX display
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Noncritical operating system and switch diagnostic codes

If a noncritical operating and switch diagnostic test fails, the HEX display stops at 
the failed test. Remaining diagnostics are not performed. The boot sequence 
continues, but server functionality can be compromised.

The following table shows the noncritical operating system and switch diagnostic 
codes with their corresponding failure codes.

Note: While the test is in progress, the following codes might appear for a short 
period. If these messages display temporarily (that is, no longer than one second), a 
problem does not exist.

Status code Operation description Failure code

HOST Continuation of BIOS diagnostics

The monitor displays the BIOS boot 
screen. 

If a noncritical error occurs, the server 
continues the boot sequence. 

P:XX

NT Windows NT boot sequence started

Note: If the CallPilot server software is 
not installed, the HEX display remains at 
NT. (This can occur if you are performing 
a system rebuild.) During CallPilot 
software installation, the 8051 device 
driver is copied to Windows NT, at which 
point the HEX display continues as 
described below.

P:XX 

Note: For a description, see 
“P:XX failure codes” on page 
38.

CDLN 8051 device driver on Windows NT has 
started; beginning of Cardlan interface 
communication (DS30 interface 
initialization)

The system controller communicates 
with the switch, indicating that two cards 
are installed, and waits for switch 
acknowledgement.

CDLN

Neither of the DS30 interfaces 
were initialized (both failed).

C:01 Initialization of the first DS30 
interface

C:01

Initialization of the first DS30 
interface failed. The second 
DS30 interface is OK.
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P:XX failure codes
P:XX indicates a BIOS diagnostic error, where XX represents a two-character code. 
If the error is a critical error, the boot cycle might halt. If the error is a noncritical 
error, the error code is reported in the Windows NT system event log after the 
operating system boot sequence completes and the CallPilot 8051 device driver 
starts.

Note: If CallPilot is not installed, no event is logged.

C:02 Initialization of the second DS30 
interface

C:02

Initialization of the second 
DS30 interface failed. The first 
DS30 interface is OK.

OK Switch acknowledgement complete

The Windows NT bootup is complete, 
and CallPilot Fault Management takes 
over.

CRI, FAIL, MAJ, MIN, or 
WARN

ATTENTION
POST Terminal errors that result in a system halt do not 
appear on the HEX display. If you are not able to use the 
HEX display to determine the cause of a system halt, 
contact your Nortel Networks technical support 
representative.

Status code Operation description Failure code
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Bootup sequence description

Introduction

The following table describes the bootup sequence and the diagnostic stages that 
occur. The entire sequence occurs when you do one of the following:

■ You lock the 201i into position on the IPE shelf or Option 11 and the 201i 
powers up.

■ You press the reset button on the 201i faceplate to perform a hardware restart.

Note: If you restart Windows NT by clicking the Shut Down and Restart buttons, the 
boot sequence starts at stage 9. However, the HEX display behaves as follows:

■ The DOWN message remains displayed until the Windows NT boot sequence 
starts.

■ The DOWN message does not scroll.

Stage Description HEX display
Status 
LED

1 Internal RAM self-test

This is the start of critical startup diagnostics for 
the 8051 system controller. If any of the tests fail, 
the bootup cycle is halted.

Approximate duration: less than 1 second

T:01 ON

2 ALU self-test

Approximate duration: less than 1 second

T:02 ON

3 Address mode self-test

Approximate duration: less than 1 second

T:03 ON

4 Boot ROM self-test

Approximate duration: less than 1 second

T:04 ON

5 Timer self-test

Approximate duration: less than 1 second

T:05 ON

6 Watchdog self-test

Approximate duration: less than 1 second

T:06 ON

7 EEPROM self-test

This is a noncritical diagnostic. If it fails, this is a 
noncritical error, and the boot cycle continues.

Approximate duration: less than 1 second

T:07 ON
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8 End of system controller self-tests. No errors were 
found.

Approximate duration: less than 3 seconds

T:08 blinks 
three 
times

9 Beginning of BIOS diagnostics. 

Note: The BIOS splash screen appears and HOST 
scrolls across the HEX display.

Approximate duration: 7 seconds

HOST ON

10 Beginning of Windows NT boot sequence

The monitor displays the Windows NT boot 
selection menu. 

Select one of the following:
---------------------------
1 Windows NT 4.0 (Server (Default

within 30 secs)
2 Windows NT 4.0 Server (VGA mode)
3 Load Previous Operating System

on C:

Choose an option[1,2,3]?1

A timer counts down from 30 seconds. If you do 
not press a key within 30 seconds, the boot menu 
times out and, by default, loads Windows NT.

If you press a key, the timeout is disabled. Use the 
up and down arrow keys to select the boot option: 
Windows NT 4.0 Server or Windows NT 4.0 
Server (VGA mode).

Note: Use option 2 only if the monitor is not able 
to support resolution greater than 640 x 480 pixels. 
Option 3 is an option provided automatically with 
the Windows NT software. There is no need to use 
it with the 201i server.

NT OFF

Stage Description HEX display
Status 
LED
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10 
(cont)

The 201i server boots Windows NT. The monitor 
does the following:

■ switches to blue screen and continues booting

■ outputs checkdisk information to make sure no 
sectors are corrupted

■ displays the Windows NT splash screen and 
logon prompt

Approximate duration of Windows NT boot 
sequence: 60 seconds

NT OFF

11 Completion of operating system boot sequence. 
The 8051 system controller is running normally.

OK OFF

12 The 201i CallPilot software loads. 

OK means that CallPilot has loaded. CallPilot 
Fault Management takes over.

If FAIL, WARN, CRI, MAJ, or MIN appear 
instead of OK, a fault has occurred. Use the system 
and administration client event logs and Alarm 
Monitor to determine what happened. 

Approximate duration: 5 minutes

One of the following, 
as applicable:

■ BOOT

■ PASS

■ FAIL

■ WARN

■ CRI

■ MAJ

■ MIN

OFF

Stage Description HEX display
Status 
LED
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Section C: Troubleshooting bootup 
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What to do when the 201i server fails to boot 
into service

Introduction

This section suggests tasks you can perform to determine why the 201i server fails 
the bootup cycle.

To determine why the 201i server failed to boot into 8051

1 Make a note of any diagnostic codes.

2 Try restarting the server by pressing the reset button on the 201i server 
faceplate.

3 During the boot sequence, view the diagnostic codes on the HEX display for 
failures.

For a description, see “Bootup sequence description” on page 39.

Note: Allow five minutes for the boot cycle to complete.

4 View the event logs.

For instructions, see page 46.

5 Refer to the CallPilot Troubleshooting Reference for other suggestions.

This document is continually being updated by Nortel Networks and is made 
available on the Nortel Networks Partner Business Center web site at 
http://www.nortelnetworks.com/partnercenter. 

Note: If you are not a distributor, then contact your Nortel Networks technical 
support representative for assistance. 

6 If you still cannot find the boot failure cause, call your Nortel Networks technical 
support representative.

To determine why the 201i server failed to boot into CallPilot

1 Make a note of any diagnostic codes.

2 Try restarting the server by pressing the reset button on the 201i server 
faceplate.

3 During the boot sequence, view the diagnostic codes on the HEX display for 
failures.

For a description, see “Bootup sequence description” on page 39.

Note: Allow five minutes for the boot cycle to complete.
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4 Refer to the CallPilot Troubleshooting Reference for other suggestions.

This document is continually being updated by Nortel Networks and is made 
available on the Nortel Networks Partner Business Center web site at 
http://www.nortelnetworks.com/partnercenter. 

Note: If you are not a distributor, then contact your Nortel Networks technical 
support representative for assistance. 

5 If you still cannot find the boot failure cause, call your Nortel Networks technical 
support representative.
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Viewing event logs

Introduction

When the 201i server boot cycle is complete, and if the CallPilot server has been 
configured (see Part 3 of this binder), the HEX display should show PASS. 

If, however, the HEX display shows FAIL, CRI, MAJ, MIN, or FAIL instead, a fault 
has occurred. To determine what happened, you can use the following:

■ Windows NT Event Viewer on the 201i server (see “To use the Windows NT 
Event Viewer on the 201i server” on page 47)

■ Event Browser or Alarm Monitor on the administrative client PC 

For more information, do one of the following:

■ See “Using the Alarm Monitor, Event Browser, and Maintenance window” 
on page 67.

■ Refer to the Monitoring and Security Guide for the Administrator.

Note: The Event Browser and Alarm Monitor include online Help for events, which 
might help you resolve the problem. If you cannot log on to the CallPilot system 
from the administrative client PC due to server problems, use the Windows NT 
Event Viewer.

Types of event logs

Three types of event logs are available from the Event Viewer, as follows:

Log type Description

System Logs events by Windows NT 4.0 components, including 
RAS or other WinNT services.

Security Logs security events, such as logons, logoffs, illegal access, 
and so on. This option is available only to users with 
Administrative access.

Applications Logs events by application, such as database file errors, and 
so on.
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To use the Windows NT Event Viewer on the 201i server

1 Click Start > Programs > Administrative Tools > Event Viewer.

Result: The Event Viewer window appears.

2 The System Log appears by default. 

To view the Application Log, click Log > Application.

Result: The Application Log similar to the following window appears:
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3 Look for error codes flagged with or that have occurred since the last 
boot.

Note: Each error is date and time stamped.  indicates major or critical 
errors.  indicates minor errors.

4 To determine the cause of the error, select and then double-click the error.

Result: A description of the error appears.

Note: The following Event Detail dialog box is an example of an error 
description from the Application Log:

5 Use the description to fix easily solvable errors.

Note: If the error persists or does not suggest a solution, contact your Nortel 
Networks support representative.

6 Click Close. 

Result: The event log reappears.

7 Click Log > Exit.

Result: The Event Viewer closes.

Where to get more information

For more information about using the Windows NT System Event Viewer, click 
Help > Contents in the Event Viewer window.
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Section D: Viewing installation and 
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Viewing installation and configuration log files

Installation or upgrade event log file

The installation event log tracks events associated with any install, reinstall, upgrade, 
or uninstallation operation. This log also tracks any fatal errors that interrupt these 
operations. 

Use any text editor (for example, Notepad) to view the installation event log file 
located on the server in C:\sysops\sysops.log. 

Configuration Wizard log file

Use any text editor (for example, Notepad) to view the Configuration Wizard log file 
located on the server in D:\ Nortel\ConfigWizard\ConfigWiz.log.
50 CallPilot



October 2000            Troubleshooting your CallPilot system
Section E: Performing Windows NT online 
diagnostics
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Overview

Introduction

This section outlines how to access the run-time online diagnostics provided by the 
Windows NT server software.

Windows NT diagnostics

The Windows NT 4.0 system provides tools that can be used to diagnose and debug 
system problems, including the following:

■ Windows NT Diagnostics

■ Event Viewer

TCP/IP diagnostics

This section describes the following TCP/IP diagnostic tools available for the 
network adapter. The first three tools are the most useful:

■ ipconfig

■ ping

■ tracert

■ arp

■ nbtstat

■ netstat

These utilities help you verify network connectivity. Network connectivity is 
essential to CallPilot operation. These utilities will help you to thoroughly test the 
network interface and isolate any configuration problems. 

. 

CAUTION

Risk of software corruption
Do not run any utilities that are not documented in this manual.
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Checking hardware using Windows NT 4.0 
diagnostics

Introduction

The Windows NT 4.0 system provides tools that can be used to diagnose and debug 
system problems, including the following tools:

■ Windows NT Diagnostics

■ Event Viewer

Windows NT Diagnostics window

The Windows NT 4.0 Diagnostics window allows you to view details about the 
system and network components. 

You can open the following tabs on the Diagnostics window to display specific 
information: 

■ Version 
■ System
■ Display
■ Drives
■ Memory
■ Services
■ Resources
■ Environment
■ Network
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Windows NT Diagnostics window

To access Windows NT 4.0 diagnostic tools

1 Log on to Windows NT.

2 Click Start > Programs > Administrative Tools (Common) > Windows NT 
Diagnostics.

Result: The Windows NT Diagnostics window appears.

3 Click the appropriate tab to view information concerning the system and 
network.

The following table identifies the types of details available on each tab:

Select To display details about

Version Version
Registration

System System identifier
HAL
BIOS information
Processors
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Event Viewer

The Windows NT 4.0 Event Viewer provides event logs to help you diagnose and 
debug system problems. 

For instructions on using the Event Viewer, see “Viewing event logs” on page 46.

Display BIOS information
Adapter
Driver

Drives Drives by type or letter

To view specific details, select a drive, and then click 
Properties to view details for the drive, including size, labels, 
and so on.

Memory Memory, including totals, physical and kernel memory, commit 
charge, kernel

Services Service and state for both services and devices

To view specific details, select a service, and then click 
Properties to view details, including pathname, dependencies, 
service flags, and so on.

Resources Click one of the following buttons to display information about 
the resources available on the system:

■ IRQ

■ I/O Port

■ DMA

■ Memory 

■ Devices

To view specific details, select a resource, and then click 
Properties.

Environment Variable and value for both system and local user

Network Click one of the following buttons to display information about 
the network and components:

■ General 

■ Transports 

■ Settings 

■ Statistics 

Select To display details about
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Invoking and interpreting TCP/IP diagnostics

Introduction

This section describes the following TCP/IP diagnostic tools available for the 
network adapter. The first three tools are the most useful:

■ ipconfig (below)

■ ping (page 57)

■ tracert (page 58)

■ arp (page 59)

■ nbtstat (page 60)

■ netstat (page 62)

These utilities help you verify network connectivity. Network connectivity is 
essential to CallPilot operation. These utilities help you to thoroughly test the 
network interface and isolate any configuration problems. 

The ipconfig command

The ipconfig command displays IP configuration information. 

Ipconfig default
Running the command without flags displays the IP address, subnet mask, and 
default gateway for each adapter bound to TCP/IP.

Ipconfig command syntax
ipconfig /[ ]

The following flags are available for the ipconfig command:

Flag Description

/? Displays Help information.

/all Displays full configuration information.

/release Releases the IP address for the specified adapter.

/renew Renews the IP address for the specified adapter.
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To run the ipconfig command from Windows NT 4.0

1 Click Start > Programs > Command Prompt to display the MS-DOS command 
prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ipconfig <with appropriate parameters>.

Example: ipconfig /all

3 Press Enter.

Result: The system runs the ipconfig utility.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

The ping command

The ping command sends an echo request to a specified host. Use this command to 
verify network connectivity to the remote device.

Ping command syntax
The ping command uses the following syntax:

ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS]
[-r count] [-s count] [[-j host-list] | [-k host-list]]
[-w timeout] destination-list

Parameter Description

-t Pings the specified host until interrupted.

-a Resolves addresses to host names.

-n count Specifies the number of echo requests to send.

-l size Sends buffer size.

-f Set Don’t Fragment flag in packet.

-i TTL Time To Live

-v TOS Type Of Service

-r count Record route for count hops

-s count Time stamp for count hops

-j host-list Loose source route along host list

-k host-list Strict source route along host list

-w timeout Timeout in milliseconds to wait for each reply
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To run the ping command from Windows NT 4.0

1 Click Start > Programs > Command Prompt to display the MS-DOS command 
prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ping <destination IP address:> (for example, 
ping 200.286.32.0:).

3 Press Enter.

Result: The system displays the ping results.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

The tracert command

This utility determines the route taken to a destination.

How tracert works
The tracert utility follows several steps to complete its task:

■ Tracert sends Internet Control Message Protocol (ICMP) echo packets with 
varying Time-To-Live (TTL) values to the destination.

■ Each router along the path must decrement the TTL on a packet by at least 1 
before forwarding it, so the TTL is effectively a hop count. 

■ When the TTL on a packet reaches 0, the router sends back an ICMP Time 
Exceeded message to the source system.

■ Tracert determines the route by sending the first echo packet with a TTL of 1 
and incrementing the TTL by 1 on each subsequent transmission until the target 
responds, or the maximum TTL is reached. 

■ Tracert then examines the ICMP Time Exceeded messages sent back by 
intermediate routers.

Tracert syntax
tracert [-d] [-h maximum_hops] [-j host_list] [-w timeout] 
[target_name]

Tracert parameters
The tracert command uses the following parameters:

Parameter Description

-d Specifies not to resolve addresses to hostnames.

-h maximum_hops Specifies the maximum number of hops to search for 
the target.

-j host-list Specifies a loose source route along the 
host list.
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To run the tracert command from Windows NT 4.0

1 Click Start > Programs > Command Prompt to display the MS-DOS command 
prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type the following command:

tracert [-d] [-h maximum_hops] [j host_list] [-w timeout] [target name] 

Example: tracert 200.286.0.32 210 200.236.0.04

3 Press Enter.

Result: The system runs the tracert utility.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

The arp command

The arp command displays and modifies the IP-to-physical address translation tables 
used by Address Resolution Protocol (arp).

Arp command syntax
The arp command uses the following syntax:

arp -s inet_addr eth_addr [if_addr]

arp -d inet_addr [if_addr]

arp -a [inet_addr] [-N if_addr]

-w timeout Waits the number of milliseconds specified by the 
timeout for each reply.

target_name The name of the target host.

Parameter Description

-a Displays current arp entries by interrogating the current 
protocol data. If inet_addr is specified, the IP and 
physical addresses for only the specified computer 
appear. If more than one network interface uses arp, 
entries for each arp table appear.

-g Same as -a.

inet_addr Specifies an Internet address.

Parameter Description
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To run the arp command from Windows NT 4.0

1 Click Start > Programs > Command Prompt to display the MS-DOS command 
prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type arp with the required parameters (for example, 
arp -g 200.286.0.32).

3 Press Enter.

Result: The system runs the arp command.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

The nbtstat command

The nbtstat command displays protocol statistics and current TCP/IP connections 
using NBT. This command is available only if the TCP/IP protocol is installed.

Nbtstat command syntax
The nbtstat command uses the following syntax:

nbtstat [-a remotename] [-A IP address] [-c] [-n] [-R] [-r]
[-S] [-s] [interval]

if_addr Specifies the Internet address of the interface whose 
address translation table should be modified. If not 
present, the first applicable interface is used.

eth_addr Specifies a physical address.

-N if_addr Displays the arp entries for the network interface 
specified by if_addr.

-d Deletes the host specified by inet_addr.

-s Adds the host and associates the Internet address 
inet_addr with the Physical address eth_addr. The 
physical address is given as six hexadecimal bytes 
separated by hyphens. The entry is permanent.

Parameter Description

-a remotename Lists the remote computer’s name table using its name.

-A IP address Lists the remote computer’s name table using its IP 
address.

Parameter Description
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To run the nbtstat command from Windows NT 4.0

1 Click Start > Programs > Command Prompt to display the MS-DOS command 
prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type nbtstat with the required parameters.

3 Press Enter.

Result: The system runs the nbtstat utility.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

-c Lists the contents of the NetBIOS name cache giving 
the IP address of each name.

-n Lists local NetBIOS names. Registered indicates that 
the name is registered by broadcast (Bnode) or WINS 
(other node types).

-R Reloads the LMHOSTS file after purging all names 
from the NetBIOS name cache.

-r Lists name resolution statistics for Windows 
networking name resolution. On a Windows NT 
computer configured to use WINS, this option returns 
the number of names resolved and registered through 
broadcast or through WINS.

-S Displays both client and server sessions, listing the 
remote hosts by IP address only.

-s Displays both client and server sessions, and attempts 
to convert the remote host IP address to a name using 
the HOSTS file.

interval Displays selected statistics, pausing interval seconds 
between each display. Press CTRL+C to stop 
displaying statistics. Without this parameter, nbtstat 
prints the current configuration information once.

Parameter Description
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The netstat command

The netstat command displays current TCP/IP network connections and protocol 
statistics.

Netstat command syntax
The netstat command uses the following syntax:

netstat [-a] [-e] [-n] [-s] [-p proto] [-r] [interval]

To run the netstat command from Windows NT 4.0

1 Click Start > Programs > Command Prompt to display the MS-DOS command 
prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type netstat with the required parameters.

3 Press Enter.

Result: The system runs the netstat utility.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

Parameter Description

-a Displays all connections and listening ports.

-e Displays Ethernet statistics. This can be combined with 
the -s option.

-n Displays addresses and port numbers in numerical 
form.

-s Displays per-protocol statistics. 

-p proto Shows connections for the protocol specified by proto. 
Proto can be tcp or udp. If used with the -s option, proto 
can be tcp, udp, or ip.

-r Displays the contents of the routing table.

interval Redisplays selected statistics, pausing between each 
display. Press CTRL+C to stop redisplaying.
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Understanding fault management

Introduction

Fault management is a term that describes how the CallPilot server detects and 
notifies you of potential or real hardware problems (faults). 

The server processes events to detect hardware problems and raises alarms to notify 
you when these problems occur. 

Event processing

An event is any change in system configuration or operational state. An event is also 
any action taken by the system that requires user notification. Events can be as 
insignificant as a user logon attempt or as serious as a faulty MPC-8 card switching 
to disabled status. 

All events are reported to the Fault Management Server, an invisible subsystem 
within the server. The Fault Management Server enables the server to listen and 
respond to its clients.

The interaction is called event processing and is the means by which the server 
detects hardware faults. 

Alarm notification

Many events occur as part of the normal operation of the server. Other events 
represent potential or real problems. When these events occur, an alarm is raised to 
notify you.

When an alarm appears in the Alarm Monitor, you must investigate the problem, 
isolate it, and then fix the cause of the problem. When you fix the problem, the alarm 
is cleared from the Alarm Monitor. 

To isolate and fix hardware problems, see Section A: “Detecting, isolating, and 
fixing hardware problems,” on page 65.
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Section A: Detecting, isolating, and fixing 
hardware problems

In this section
Overview 66

Using the Alarm Monitor, Event Browser, and Maintenance window 67
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Overview

Introduction

This section provides guidelines on how to detect, isolate, and fix potential or real 
hardware problems:

■ “Detecting hardware problems” below provides information on the different 
ways in which you typically become aware of hardware problems.

■ “Using the Alarm Monitor, Event Browser, and Maintenance window” on page 
67 describes how to work with the Alarm Monitor, Event Browser, and 
Maintenance window. Use these tools to isolate the cause of problems and plan 
a strategy to fix hardware problems.

Component dependencies

The status of some components are dependent on the operational status of other 
components. If a component fails or is stopped, the dependent components go out of 
service. 

Detecting hardware problems

Typically, you first become aware of a hardware problem when an alarm is raised. 
All hardware faults produce an alarm (or series of alarms, depending on the 
problem) in the Alarm Monitor. 

Note: By default, the Alarm Monitor appears as soon as an alarm is raised. It does 
not appear if Alerting Off has been set in the SMI window. For more information on 
setting or resetting the alerting feature, refer to the CallPilot Monitoring and 
Security Guide for the Administrator.

Other indications
Other indications of a hardware problem include the following:

■ call processing difficulties, such as busy signals, static, dropped calls, trouble 
connecting, and cross talk (hearing other conversations)

■ system administrator logon difficulties

■ alert icons on the Maintenance window

Component Dependent components 

Timeswitch all Multimedia and DS0 channels 

MPC all multimedia channels on the MPC-8 card

DS30x all DS0 channels associated with the DS30x 
interface
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Using the Alarm Monitor, Event Browser, and 
Maintenance window

Introduction

Use one of the following methods to isolate and plan a strategy to fix a hardware 
problem:

■ Use the Alarm Monitor to investigate one or more raised alarms.

■ Use the Event Browser to investigate a series of events that occurred around the 
time an alarm was raised.

■ Use the Maintenance window to get status information for any suspect 
components. For some components, you can use the Diagnostic tab on the 
Maintenance window to run a diagnostic test.

Note: For detailed information on how to use the Alarm Monitor and Event Browser 
(for example how to set preferences), refer to CallPilot Monitoring and Security for 
the Administrator.

Using the Alarm Monitor

Each alarm in the Alarm Monitor has Help text that often provides a solution to the 
problem. If the solution is not apparent, use the Event Browser or the Maintenance 
window to further investigate the problem.
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To investigate using the Alarm Monitor

1 Double-click the first critical or major alarm.

Result: The Help window appears. 

2 View the description and recovery action.

3 Repeat steps 1 and 2 for a few more alarms.

4 If the solution to the problem is not apparent, obtain the return code of the first 
event and continue the investigation by using the Event Browser (see “Using the 
Event Browser” below).

Using the Event Browser
The Event Browser lets you view events that have been recorded in the server log. 
The event listing can help you better determine the root cause of the problem. Use 
the Event Browser to view the time the event occurred, the object that generated the 
event, and the cause of the event.

To investigate using the Event Browser

1 Double-click an event that appears to be related to the problem, or an event that 
occurred near the time the alarm was raised. 

2 View the description and recovery action.

3 Repeat steps 1 and 2 for a few more events.

4 If the solution to the problem is not apparent, contact your distributor.
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Using the Maintenance window

If you suspect or discover a problem with the serial ports, an MPC-8 card, or the 
timeswitch, use the Diagnostic tab on the Maintenance window. You can view the 
results of the last diagnostic test run against the component. This produces a list of 
components that might be causing the problem. A probability percentage is listed 
with each component that reflects how probable it is that replacing the component 
will fix the problem. 

For information on all aspects of the Maintenance window, see Section B: “Working 
with the Maintenance window,” on page 71.

For information about using the Maintenance window to view the results of the last 
diagnostic test, see “Viewing the last diagnostic results” on page 88.
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Section B: Working with the Maintenance 
window

In this section
Introducing the Maintenance window 72

Obtaining general information about components 78

Viewing component states 80

Starting and stopping components 83

Running integrated diagnostics 86

Viewing the last diagnostic results 88
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Introducing the Maintenance window

Introduction

Use the Maintenance window to do the following:

■ Obtain general information about components.

■ View component states.

■ Start and stop components.

■ Run integrated diagnostic tests.

■ View the results of the last diagnostic test run against a component.

■ Obtain replacement part numbers for components.

What the Maintenance window provides

All physical and logical hardware components are listed in the tree on the 
Maintenance window. This tree shows how components relate to each other. For 
example, eight multimedia channels exist as subcomponents for each MPC-8 card.

When you select a component in the Maintenance window, at least one of the 
following tabs appears: 

Tab Description

General This page shows general technical information about the 
selected component. 

Maintenance This page shows the state of the selected component. You 
can also take some components out of service from this 
page. 

Diagnostics This page enables you to run component-specific 
diagnostics.

Replacement This page shows replacement part numbers for selected 
components.
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The General tab

Use the General tab to view general information about components. 

Box Description

Attribute Shows component-specific general technical information.

Value Shows additional details, such as the speed of a selected 
device.
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The Maintenance tab

Use the Maintenance tab to view the state of the highlighted component, and to start 
and stop a component before running a diagnostic test.

Box Description

State Specifies the state of the highlighted component.

Administrative This is a Desktop Management Interface (DMI) summary 
state. You do not need this state.

Availability Not applicable for 201i.

Operational Not applicable for 201i.

Usage Not applicable for 201i.

Start Use this button to put the selected device in service.

Courtesy stop Use this button to take the selected device out of service 
after all calls are finished. This prevents any calls from 
being disconnected.
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The Diagnostics tab

Use the Diagnostics tab to run a diagnostic test or to view the results of the last 
diagnostic test run on a component.

Stop Use this button to take the selected device out of service 
immediately. All calls in progress are disconnected.

Power Up Use this button to power up an MPC-8 card that had been 
powered down. 

For more details, see “To remove an MPC” on page 131.

Power Down This button can be used only for MPC-8 cards on a 201i 
server. Use this button to power off an MPC-8 card prior to 
replacing it. 

For more details, see “To remove an MPC” on page 131.

Box Description
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Box Description

List of Diagnostics for 
Selected Device

Shows the diagnostic tests that are available for the 
highlighted component.

When you click a test in this list, a description of the test 
appears in the Description box. Instructions for running the 
test appear in the Instructions box.

Run Use this button to run the selected diagnostics.

Stop Use this button to stop the selected diagnostics.

Description Shows a comment or description for the selected diagnostic 
test.

Last Result Use this button to view the results of the last diagnostic test.

The results include a list of Field Replaceable Units (FRU), 
which, if replaced, might fix the problem. Each FRU is 
shown with a percentage that shows how probable it is that 
the component caused the hardware problem.

Instructions Shows the instructions for running the selected diagnostic 
test.
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The Replacement tab

Use the Replacement tab to find the part number for the component that you need to 
replace.

Box Description

Description Shows the name of the highlighted component.

Manufacturer Shows the manufacturer of the component.

Model Revision Shows the revision number for the component.

Part Number Shows the part number for the component.

Technical Support URL Shows a web site address where you can get technical 
support.
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Obtaining general information about 
components

Introduction

Find general technical information for each hardware component listed in the tree 
using the General tab on the Maintenance window.

For a description of the General tab, see “The General tab” on page 73.

Type of technical information

Technical information about hardware components typically includes the following 
details:

■ the name, class, type, series, or version of a component

■ various capabilities of a component (for example, the speed of a CPU)

■ the available disk space

Getting there   CallPilot system > System Administration > Maintenance Administration > 
Maintenance
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To view component details

1 In the left pane of the Maintenance window, select the hardware component for 
which you want to obtain information.

Result: The General page appears with general information shown. 
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Viewing component states

Introduction

View a component’s state to determine the general condition of the component, 
including whether the component is disabled or off duty. You can view the state of 
components that are listed in the Maintenance tab on the Maintenance window.

For a description of the Maintenance tab, see page 74.

Component states

The state of a hardware component changes depending on the following factors: 

■ whether the component is currently involved in processing a call

■ whether a diagnostic test is being run on the component 

■ whether the component is out of service 

You can determine the state of a component by looking at the State box on the 
Maintenance tab. 

State Description

Active The component is working and currently involved in 
processing a call. 

Idle The component is working but not currently involved in 
processing a call.

Uninstalled The component is not installed or properly configured. This 
usually happens only when the system is being configured, 
or if the database is corrupted.

Shutting Down The component is in the process of stopping. 

This state occurs quickly and is immediately followed by Off 
Duty.

Loading The component has been started, which takes it out of the 
Off Duty state. 

This state occurs quickly and is immediately followed by 
Idle.

No resources The hardware required for the component to operate is not 
installed or is not operating properly. 

Off duty The component has been stopped.

Remote Off Duty The component has been taken out of service at the switch.
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DMI details 
These states (Administrative, Availability, Operational, and Usage) are standard 
Desktop Management Interface (DMI) states. They are shown for administrators 
who understand and use the DMI standard in other aspects of their jobs. You do not 
need to use the DMI states; the summary state listed in the State box is provided 
instead. 

Alert icons
If one of the following icons appears next to a component in the tree, then the 
component or one of its subcomponents is experiencing a problem:

Getting there  CallPilot system > System Administration > Maintenance Administration > 
Maintenance

To view the state of a hardware component 

1 In the left pane of the Maintenance window, select the hardware component. 

Result: The General page appears.

Icon Description

 This means that a diagnostic test run on the component has failed, 
and the component has been placed into disabled status. 

You must view the last results of the diagnostic test. See “Viewing the 
last diagnostic results” on page 88.

This means that a problem exists with one of the component’s 
subcomponents. 

Expand the tree to locate the subcomponent with the problem. 
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2 In the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 View the state of the selected component in the State box.
82 CallPilot



October 2000            Using the administrative PC to diagnose the server
Starting and stopping components

Introduction

When you stop a component, you take it out of service and prevent it from operating. 
You must stop a component before you can run a diagnostic test on it. 

After you replace the component or run a successful diagnostic test, put the 
component back into service by starting it.

Start and stop components from the Maintenance tab on the Maintenance window. 
For a description of the Maintenance tab, see page 74.

Components that can be started and stopped

Only the following components can be started and stopped.

If you want to start or stop more than one or two multimedia or DS0 channels, use 
the Channels windows. Refer to the CallPilot Monitoring and Security Guide for the 
Administrator for more information.

Component Effect of stopping Replaceable?
Diagnostics 
available

Timeswitch This is not supported by the 
201i server.

No No

MPC-8 cards Takes the selected MPC-8 card 
out of service.

Yes Yes

Multimedia (DSP) 
channels

Takes the selected DSP channel 
out of service.

No No

Call channels Takes the selected call channel 
out of service.

No No

DS30x link Takes the selected DS30x link 
out of service.

Yes No
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Stop versus Courtesy stop

The following two methods of taking a component out of service allow you to 
choose how active calls are affected.

Courtesy stop 
A Courtesy stop takes the component out of service only after the component has 
finished processing the active call. If the component is currently processing a call, 
the call is not dropped. If the component is not currently in use, it is taken out of 
service immediately. This method is preferred over a regular Stop.

Stop
A stop takes the component out of service immediately, regardless of whether the 
component is currently processing calls. All active calls are dropped. Typically, you 
perform a Stop only when severe problems that are affecting a large number of 
incoming calls occur or if your organization determines a special need for it.

Getting there  CallPilot system > System Administration > Maintenance Administration > 
Maintenance

To start or stop a component

1 In the left pane of the Maintenance window, select the hardware component 
you want to start or stop. 

Result: The General page appears.
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2 In the right pane, click the Maintenance tab.

Result: The Maintenance page appears. 

3 Click Courtesy stop, Stop, or Start. 
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Running integrated diagnostics

Introduction

You should run diagnostic tests from the Diagnostics tab on the Maintenance 
window in the following circumstances: 

■ After installing or reinstalling a component, make sure it is operating properly. 

Note: A component must be Off Duty [stopped] before you can run the 
diagnostic test. See “Starting and stopping components” on page 83.

■ Run the tests if the CallPilot server experiences trouble processing incoming 
calls. 

Problems include static, dropped calls, and cross talk (hearing another 
conversation).

Note: For a description of the Diagnostics tab, see “The Diagnostics tab” on page 
75.

If a diagnostic test fails or cannot be run

If a warning box appears, the diagnostic test cannot be run because a prerequisite 
condition has not been met. If a diagnostic test fails, the failure is indicated at the 
bottom of the Diagnostics tab. 

In both cases, check the Alarm Monitor to determine the reason and the appropriate 
action to take. (See “Detecting, isolating, and fixing hardware problems” on page 
65.)

To run a diagnostic test

1 In the left pane of the Maintenance window, select the hardware component for 
which you want to run a diagnostic test.

Result: The General page appears.
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2 In the right pane, click the Diagnostics tab.

Result: The Diagnostics page appears. 

3 Select the diagnostic test you want to run.

4 Click Run.

5 View the diagnostic test results at the bottom of the Diagnostics page. 
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Viewing the last diagnostic results

Introduction

If the Alarm Monitor and Event Browser do not provide a solution to a hardware 
problem, you might need to replace or service a component. If the problem rests 
with a component that is not replaceable because it is not a physical entity (such as 
the timeswitch), you must either replace its parent component or contact your Nortel 
Networks technical support representative, depending on the component.

Replaceable parts are called Field Replaceable Units (FRUs). View the last 
diagnostic test result in the Diagnostics tab on the Maintenance window to obtain a 
list of FRUs that, when replaced, will likely fix the problem.

Notes: 

■ For general information on investigating hardware problems, see “Detecting, 
isolating, and fixing hardware problems” on page 65.

■ For a description of the Diagnostics tab, see page 75.

Field replaceable units

When you view the last results of a failed diagnostic test, a Diagnostic Result 
description appears at the bottom of the Diagnostics tab. This description includes a 
list of components that might have caused the problem. 

Each FRU is shown with a percentage that represents how probable it is that the 
component caused the hardware problem. Use these percentages as a guide to 
determine which component to try replacing first; the higher the percentage of 
probability, the better the chance that replacing the FRU will fix the problem. 

To view the last diagnostics result 

1 In the left pane of the Maintenance window, select the hardware component. 

Result: The General page appears.

2 In the right pane, click the Diagnostics tab.

Result: The Diagnostics page appears.

3 Click Last Result.
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Result: The results of the last diagnostic test appear at the bottom of the 
Diagnostics page.

4 View the last results to determine what action to take.

Last diagnostic results

The results of the last diagnostic test display the following information at the bottom 
of the Diagnostics tab: 

Information Description

Target Object This is the component selected in the tree.

Diag ID This is the ID of the diagnostic test that was run. The 
diagnostics IDs and descriptions are listed in the List of 
Diagnostics for Selected Device window on the 
Diagnostics page.

Diag Result The diagnostic result includes a return code and whether 
the diagnostic test passed or failed. 
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Result Description This section appears only when the diagnostic test fails. 
This is a more detailed description of the problem. This 
description includes the following details:

■ the error that was encountered

■ a list of components that might have caused the error 
with a probability percentage

■ troubleshooting instructions

Information Description
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Overview

Introduction

The following table lists the CallPilot system utilities:

Accessing the system utilities

All CallPilot customer administrator tools are accessible from the server using 
Start > Programs > CallPilot > System Utilities.

Utility Description

Diagnostics Tool Allows CallPilot startup diagnostics to be enabled or 
disabled (turned on or off).

PEP Maintenance Displays a list of installed PEPs and enables PEP 
uninstall.

Services Monitor Displays the true status of all CallPilot services 
according to the WinNT definition.

Session Trace Provides detailed information about the activity in a 
user’s mailbox and the state of the message waiting 
indicator (MWI).

System Information Displays particulars about the CallPilot System, such 
as names, keycodes, serial numbers, IP addresses, and 
system numbers.

System Monitor Displays the status of all CallPilot subsystems related 
to call processing.
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Diagnostics Tool

Introduction

The Diagnostics Tool allows you to enable or disable CallPilot startup diagnostics as 
required by the user or the system.

CallPilot startup diagnostics automatically identifies hardware problems that might 
exist when the system and its services are started (DSP, TimeSwitch, SCbus).

This tool saves time during system maintenance operations where restarts or Call 
Processing services restarts are required.

There are three recommended steps:

■ Use the Diagnostics tool to turn off CallPilot startup diagnostics.

■ Perform system maintenance.

■ Use the Diagnostics tool to turn on CallPilot startup diagnostics.

To access the startup Diagnostic Tool

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
Diagnostic Tool.

Result: The Diagnostics Tool window appears.
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To enable startup diagnostics

From the menu, choose Configuration > EMCI Startup Diag > Enable.

To disable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Disable.

ATTENTION
Nortel Networks recommends that you leave the startup 
diagnostics turned on.

When you disable CallPilot startup diagnostics, you prevent 
CallPilot from automatically identifying hardware problems 
that might exist when the system and its services are started 
(DSP, TimeSwitch, SCbus).
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PEP Maintenance utility

Introduction

The PEP Maintenance utility displays a list of all installed PEPs on the server and 
enables you to uninstall PEPS.

For information on uninstalling PEPs, refer to “Installing Performance Enhancement 
Packages” on page 209.

To access the PEP Maintenance utility

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
PEP Maintenance. 

The DMI Viewer window appears.

To view a list of all installed PEPs

1 Click the component for which you want to display the PEP list.

2 Click Show PEPs.

Result: A list of all installed PEPs appears in the left pane.
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3 If you want to review the readme file associated with a PEP, click the PEP and 
then click Read.

Result: The readme file opens in Notepad.
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Services Monitor

Introduction

The Services Monitor helps you determine whether the CallPilot server is fully 
operational. It displays true states of the CallPilot services according to Windows 
NT definition, including the states that are not available through the control panel.

Note: The fact that a service is running does not necessarily mean that it is fully 
operational. It might require some initialization, database connections, internal data 
structures, and so on.

To access the Services Monitor

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
Service Monitor.

Result: The ServiceMon window appears.

Note: A service can be running from a Windows NT perspective; however, due to 
interprocess dependencies, there might be some steps before the service is fully 
operational.
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Using the Services Monitor

The Services Monitor provides the status of each CallPilot service (for example, 
running, any pending or pausing state).

Refresh All enables the display to be refreshed. Use Set Refresh Rate to set the rate 
of refresh or set to none.
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Session Trace

Introduction

The Session Trace tool displays detailed information about the activity in a user’s 
mailbox and the state of the message waiting indicator (MWI). The session 
information includes

■ voice messaging

■ call answering

■ express messaging activity (messages composed and sent, or left in a mailbox)

■ the number of messages played or unplayed at the beginning, middle, and end 
of a session

■ messages and personal distribution lists restored into a mailbox

■ the last change to the MWI (turned on or off, or untouched)

This session information allows an administrator or technician to study the state of a 
user’s mailbox and the MWI, and to use that information to follow up on any user 
complaints. For example, a user might complain that the MWI was on, but no voice 
messages were in the mailbox when the user logged on. The session information 
might tell the administrator why the MWI was turned on.

To access the session trace tool

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
Session Trace Tool. 
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Result: The MCE Session Trace window appears.

To find a session

1 From the Session Type drop-down menu, choose the type of session.

To display a list of all session types, select All Session Types.
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2 Enter as much information in the search criteria boxes to identify the session 
you want to view.

To display a list of all users for the selected Session Type, leave the search 
criteria boxes blank.

3 Click Search to initiate the search. 

a. If you did not enter any user information, a list of users matching the 
Session Type appears at the bottom of the window.

To select a user from the list, double-click the user name to display session 
type information.

b. If you selected All Session Types for a user, the session type information 
appears to the right of the window. 

4 Double-click the session type to display the session information.

Result: The Session Type information appears at the bottom of the window.

Session type information

Call Answering session type information
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Expired messages session type information

Express Messaging session type information
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Logon OK session type information

Selective Restore session type information
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System Information

Introduction

The System Information utility displays particulars about the CallPilot system, such 
as names, keycodes, serial numbers, IP addresses, and system numbers.

To access the System Information utility

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
System Information.

Result: The CallPilot System Information window appears.

To use the System Information utility

Use this utility to view CallPilot system information at a glance.

After viewing the information on this window, click Close.
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System Monitor

Introduction

The System Monitor provides a single point of view of CallPilot call processing 
status at any time. The status provided reflects the true internal status of the Call 
Processing subsystem, including all related call processing components. This 
eliminates the need to use multiple tools to get the same information.

The System Monitor queries the current status of each component it is monitoring 
and displays them in a graphical user interface. The status of each service is obtained 
from the Windows NT Service Controller; Middleware Components status are 
obtained from the CT Media server; and the DSP and Call channels status are 
obtained by querying Middleware. 

This tool shows the status of

■ CallPilot Critical Services related to call processing

■ CT Media-based Middleware Services

■ CallPilot Call Channels and Media Channels

System Monitor is a nondestructive tool that does not alter the behavior of any 
CallPilot components.

Note: Users of this tool require an understanding of CallPilot and the components 
they want to monitor.

To access the System Monitor

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
System Monitor.
Part 5: 201i Server Maintenance and Diagnostics 105



Using CallPilot system utilities  Standard 1.0
Result: The CallPilot System Monitor window appears.

User interface

The user interface comprises the four main areas listed below. Each area indicates 
the status of the particular components of the CallPilot server:

1. Services Area for Critical Windows NT-based services

2. CT Media Services Area for Middleware-based services

3. Call Channel Area for Call Arrival/Departure activities

4. Media Channel Area for DSP channel usage activities

CallPilot Critical Services
Critical Services needed for CallPilot Call Processing include

■ CT Media Server Service

■ Telephony Server (TAPI) Service

■ MAS EMCI Service

■ MAS Notification Service

■ MCE SLEE Service

■ MCE Notification Service

■ SQL Anywhere Service

■ VBPC Load Service (useful in a DSE system)
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CT Media-based Middleware Services
Middleware resources needed for CallPilot include

■ Dialogic CT Media Server Core Service

■ Dialogic CT Media Server ISE Service

■ Call Channel Resource Service

■ Blue Call Router Service

■ Media Resource Service

■ Maintenance Service Provider Service

CallPilot Call Channels and Media Channels
Call and media channels needed for CallPilot include Multimedia Ports and Call 
Channel (DSP channel usage as well as Call Channel usage).

Online Help
To obtain a description of the various status codes for each of the window’s 
components, use the online Help.

Menu items
The System Monitor tool provides several menu items for configuration:

File Closes the tool.

Refresh rate Changes the refresh rate to a desired level.

Help Displays a legend for each status symbol shown.
Part 5: 201i Server Maintenance and Diagnostics 107



Using CallPilot system utilities  Standard 1.0
108 CallPilot



C h a p t e r  5

Performing hardware maintenance and 
mechanical assembly
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Overview

Introduction

This chapter describes how to perform hardware maintenance and upgrade 
procedures. 

Preparing for server maintenance

The first section, “Preparing for server maintenance,” provides procedures you must 
follow before you replace a component or perform an upgrade activity. These are the 
first steps in working with the server.

Replacing components

The second section, “Replacing components,” provides procedures associated with 
field service.
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Section A: Preparing for server 
maintenance

In this section
Shutting down the server 112

Removing the server from the switch 113

Replacing the server 114
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Shutting down the server

Introduction

You prepare the 201i server for removal from the switch by shutting down the 
software. Before you shut down the 201i server, ensure that all clients are logged off.

The server is powered automatically by the switch when it is locked into position on 
an IPE shelf. The server, therefore, powers off when it is removed from the switch.

Equipment required

You need a keyboard, monitor, and mouse to perform a server shutdown.

To perform a software shutdown

1 Connect the keyboard, monitor, and mouse to the server.

2 Log on to the server.

3 Close all applications.

Note: Applications that you do not close are automatically closed when you 
perform the Windows NT shutdown.

4 In Windows NT Server 4.0, click Start.

5 Select Shut Down.

6 When the Shut Down Windows dialog box appears, do the following:

a. Click Shut down the computer?

b. Click Yes.

Result: You might also be asked if you want to save ACD proxy changes.

7 Click No.

Result: The 201i server shutdown begins.

8 Wait for one or both of the following to appear:

■ DOWN on the hex display 

■ the message It is now safe to turn off your computer.

Note: The red LED power status indicator remains lit during the shutdown until 
the system is restarted.
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Removing the server from the switch

Introduction

You must remove the server from the switch before you replace the following 
components:

■ hard drive

■ software feature key

Note: You can replace an MPC-8 card without powering down the 201i server. 

Equipment required

The following equipment is required for this procedure:

■ antistatic mat

■ antistatic wrist strap

To remove the server from the switch

1 Shut down the server.

2 Turn off the monitor.

3 Disconnect the monitor, keyboard, and mouse. 

4 Power down the peripheral SCSI devices.

5 Disconnect the SCSI cable (if connected).

6 Open the lock latches at the top and bottom of the server.

7 Grip the faceplate, and then pull the server out of the IPE shelf.

8 Place the server on a clean, static-resistant surface.

What’s next?

Replace and upgrade components as required.
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Replacing the server

Introduction

For activities that are not supported as field procedures, you must return the server to 
Nortel Networks for service. To maintain customer service, a replacement server 
must be installed on-site.

All procedures required to replace the 201i server are covered in detail in this guide.

This section summarizes the procedure for replacing the server. References are made 
to specific component replacement procedures where applicable.

To replace the server

1 If the installed server is functional, perform a complete backup of the hard disk 
as a precautionary measure.

2 Use the administration client application to take any installed MPC-8 cards out 
of service. 

3 Remove the MPC-8 cards from the faceplate of the server (see page 129).

4 Shut down the installed server (see page 112).

5 Power down and disconnect all peripherals from the server. 

6 Remove the server from the switch (see page 113). 

7 Remove the software feature key from the defective server and install it in the 
replacement server as shown on page 127.

8 Remove the hard drive from the defective server and install it in the 
replacement server as shown on page 122.

9 Install the replacement server on the switch and then reconnect the peripherals.

10 Install the MPC-8 cards removed from the defective server as shown on 
page 133.

11 Boot the server to Windows NT.

12 Run the Configuration Wizard to configure the new hardware. 

For instructions, see Part 3 of this binder.
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Section B: Replacing components

In this section
Overview 116

Replacing the IDE hard drive 120

Replacing the software feature key 127

Replacing Multimedia Processing Cards 129
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Overview

Introduction

Before you can begin component replacement, you must do the following:

■ Gather the tools you need.

■ Remove the 201i server from the switch.

■ Become familiar with component layout on the 201i server.

Equipment required

You need the following tools, based on the component you are replacing:

■ antistatic wrist strap

■ Phillips No. 1 and No. 2 screwdrivers

■ tweezers

Before you begin

Remove the server from the switch and lay it on a static-resistant surface, with the 
component side facing up. For instructions, see page 113.

If you need to replace the entire 201i server, review “Replacing the server” on page 
114. Then review the procedures for installing the server and conducting diagnostic 
tests. 
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201i server component diagram: exploded view

The following diagram identifies component locations on the 201i server:
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201i server component diagram: complete assembly

The following diagram shows the 201i server when it is completely assembled:

Legend

Item Description

1 Heat sink

2 Hard drive power cable

3 Hard drive data cable

4 Secondary backplane connector pin

G101544

12

11

10

9

8

1

2

3

4

5

6

7

118 CallPilot



October 2000            Performing hardware maintenance and mechanical assembly
5 Secondary backplane connector

6 3.5" IDE hard drive

7 Hard drive mounting bracket

8 Software feature key

9 Faceplate

10 Monitor connector

11 Mouse connector

12 Keyboard connector

Item Description
Part 5: 201i Server Maintenance and Diagnostics 119



Performing hardware maintenance and mechanical assembly  Standard 1.0
Replacing the IDE hard drive

Introduction

The hard drive rests lengthwise along the backplane side of the server. The hard 
drive is secured in place by five screws, two on the backplane edge, two through the 
motherboard, and one through the bottom edge of the stiffener.

 Equipment required

The following equipment is required for this procedure:

■ antistatic wrist strap

■ Phillips No. 1 screwdriver

Before you begin

Before you replace the hard drive, review the following:

■ “Removing the server from the switch” on page 113

■ the “201i server component diagram: exploded view” on page 117
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Hard drive assembly diagram

The following diagram shows the hard drive in its assembled state:
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To remove the IDE hard drive

1 Do the following:

a. Remove the two screws on the back of the motherboard.

b. Remove the screw on the stiffening cage.

c. Remove the two screws on the hard drive’s stiffener cage (along the 
backplane edge of the server).

See the following diagram:
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2 Do the following:

a. Dislodge the power cable from its connector and lift it away from the 
motherboard.

b. Slide one hand as far as you can beneath the hard drive so that it is 
securely supported.

Your fingers should touch the data cable connector on the motherboard.

G101447
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3 Use the pull tabs to gently remove the data cable connector from the 
motherboard. 

See the following diagram:

4 Lift the hard drive assembly away from the motherboard.

5 Do the following:

IF you are THEN

replacing the hard drive 
with a new one

continue with step 6.

keeping the hard drive but 
replacing the 201i server 

continue with “To install the hard drive” on 
page 125.

G101448
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6 Detach the hard drive bracket by removing the two screws on the bottom of the 
hard drive assembly.

7 Remove the power and data cables from the hard drive.

8 Continue with “To install the hard drive” below.

To install the hard drive

1 If you are replacing the hard drive with a new one, do the following:

a. Attach the hard drive bracket to the new hard drive.

b. Attach the power and data cables to the new hard drive.

2 Connect the power and data cables to the 201i server motherboard.

When the data cable connector is correctly aligned with the connector on the 
motherboard, press firmly down until the connector is properly seated.

. Ri

CAUTION

Risk of equipment damage
Ensure the pins on the data connector on the motherboard line up 
correctly with the data cable connector.

G101449
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3 Position the hard drive assembly in the server.

Align the hard drive’s bracket over the PCI connector on the motherboard, and 
then lower the assembly into position.

Note: The PCI connector on the motherboard is reserved for future use. 

4 Align the drive with the screw holes.

5 Replace and tighten the screws.

What’s next?

Review the procedures for installing the server and conducting diagnostic tests.

ATTENTION
The five screws you removed earlier are two different sizes. 
The three smaller screws belong to the back of the 
motherboard and the bottom edge of the motherboard’s 
stiffener cage (see steps 1a and 1b on page 122).

The two larger screws belong to the hard drive’s stiffener 
cage (along the backplane edge of the server) (see step 1c 
on page 122). 
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Replacing the software feature key

Introduction

The software feature key is a software security device. This key stores the unique 
serial number of the server.

Equipment required

The following equipment is required for this procedure:

■ Phillips No. 1 screwdriver

■ tweezers

Before you begin

Before you replace the software feature key, review “Removing the server from the 
switch” on page 113. 

Software feature key location

To determine where the software feature key is located, see the “201i server 
component diagram: exploded view” on page 117.

To replace the software feature key

1 Lift the clip holding the software feature key to the motherboard.

2 Use the tweezers to pull the software feature key out of the socket.

3 Insert the software feature key into the socket on the replacement motherboard, 
lip side up.

. 

CAUTION

Risk of of equipment damage

Ensure that you do not bend the clip so that it can no longer apply 
downward pressure.
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When the software feature key is correctly installed, it is firmly seated in its 
socket. See the following diagram:
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Replacing Multimedia Processing Cards

Introduction

The Nortel Networks MPC-8 card supports multimedia telephony services on the 
201i server. Four specially designed card slots are available for the MPC-8, and are 
located on the 201i server faceplate.

Note: The 201i server motherboard contains one built-in MPC. This MPC is known 
as MPC 1.

Supported MPC-8 card versions

The 201i server supports MPC-8 cards, Release 14 or later.

What the MPC-8 card looks like

The following is a diagram of the MPC-8 card:

G101540
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Correct card insertion

The MPC-8 card is keyed so that it fits only one way into the slot on the 201i server 
faceplate. If the card is inserted incorrectly, the card does not go all the way into the 
slot.

Location of MPC slots

There is an ejector button, slot, and LED for each MPC. The following diagram shows 
where they are located on the 201i server:

. 

CAUTION

Risk of equipment damage
If you force the card into the slot incorrectly, this can result in 
damage to the MPC-8 card and the 201i server.
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The following table describes each LED status:

To remove an MPC

1 On the administration client PC, log on to the CallPilot system.

2 Open the CallPilot Administration Client window, and click System 
Administration > Maintenance Administration > Maintenance.

3 In the left pane of the Maintenance window, select the MPC-8 card you want to 
replace. 

Result: The General page appears.

Status Description

Off The MPC is not receiving power. It is safe to remove the 
card.

On The MPC is in use. In this case, it is not safe to remove the 
card.

Off, then on The MPC has been recognized by the 201i server software 
and has been powered up.

On, then off The MPC has been successfully powered down. It is safe to 
remove the card.

ATTENTION
You can replace an MPC-8 card without powering down the 
201i server. You must, however, power down the MPC-8 card 
using the administration client software (as described in this 
procedure) before you remove it from the server.

ATTENTION
This procedure assumes that the 201i server is locked into 
position on the IPE shelf. If it is not, perform steps 8 and 9 only.
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4 In the right pane, click the Maintenance tab.

Result: The Maintenance page appears. 

5 Click Courtesy stop or Stop. 

Result: The MPC-8 card changes to an Off Duty state.

6 Click Power Down.

Result: The MPC-8 card is powered off.

7 Ensure that the MPC’s LED on the 201i server faceplate is not lit, which 
indicates that the MPC is no longer receiving power.

. 

CAUTION

Risk of data loss

If you select Stop, the selected MPC-8 card is immediately placed 
out of service.

. 

CAUTION

Risk of equipment damage
If you remove an MPC while it is receiving power, this can 
damage the MPC or the 201i server.
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8 Firmly press the MPC’s ejector button to dislodge the MPC from its slot. 

The ejector button is on the 201i faceplate underneath the MPC slot. There is 
one ejector button for each MPC slot.

9 Pull the MPC out of its slot.

To install an MPC-8 card

1 Ensure that the MPC-8 card label is facing one of the following ways:

■ facing to the right if the 201i server is inserted into the IPE shelf (see the 
following diagram):

■ facing up if the 201i server is lying horizontally on a flat surface

. 

CAUTION

Risk of equipment damage
It is possible for the MPC to eject suddenly and fall to the floor if 
you are not ready. 

G101541
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2 Insert the card into the slot, and gently push it until it is firmly in place and the 
ejector button pops back out.

3 Ensure that the MPC’s LED lights up green.

4 Enable the card and its channels.

5 Ensure that the new MPC-8 card is highlighted in the left pane of the 
Maintenance window.

6 Click Power Up.

Result: The MPC-8 card powers up.

7 Click Start.

Result: The MPC-8 card changes to an Idle state and is now operational.
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Expanding CallPilot features

In this chapter
Expanding features or channels 136
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Expanding features or channels

Introduction

This chapter summarizes how you add features or configure additional channels to 
CallPilot.

CallPilot does not support feature reduction other than for channels that have been 
previously allocated.

Requirements

Have your new keycode available. When you purchase additional features or system 
capacity, you receive a new keycode.

Expansions

CallPilot supports the expansion of features (such as number of channels or 
networking sites).

To add features or configure additional channels

If you have purchased additional features or system capacity (additional channels), 
then do the following:

1 Install the software feature key, if a new one was shipped to you. 

A new software feature key is supplied when the serial number is changed. See 
“To replace the software feature key” on page 127.

2 Run the Configuration Wizard (refer to Part 3 of this binder). In the 
Configuration Wizard, ensure you do the following:

a. Enter the new keycode and serial number.

b. Allocate new channels (if you have added channels).

c. Configure additional channels on the switch and in the Configuration 
Wizard.

ATTENTION
New channels are not automatically allocated. You must 
manually allocate them using the Configuration Wizard. 
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Recovering from corrupted software or 
a hard drive failure

In this chapter
Overview 138

Reinstalling languages 139

Recovering from corrupted software (hard drive is functioning) 140

Recovering from a hard drive failure 145
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Overview

Introduction

If the 201i server hard drive crashes, or if software becomes corrupt, then you must 
either reinstall the software or rebuild the hard drive. The descriptions below can 
help you decide if you need to perform a new installation, reinstallation, or hard 
drive recovery.

Reinstalling languages

If only the language prompts are not functioning (for example, no prompts are 
played when you log on), then you can reinstall languages to try to fix the problem. 
See “Reinstalling languages” on page 139.

Recovering from corrupted software (hard drive is functioning)

If, for example, the hard drive is functioning but the CallPilot software appears to be 
corrupted, you can reinstall the CallPilot server software. This might correct the 
problem. See “Recovering from corrupted software (hard drive is functioning)” on 
page 140. If it does not correct the problem, then you need to rebuild the hard drive. 

Recovering a CallPilot system from a hard drive failure

IF your CallPilot system is THEN 

a new CallPilot system (for example, 
the system failure occurs before or 
during CallPilot installation)

follow the procedures in “Installing the 
operating system and server software” on 
page 147 to install a new CallPilot system. 
These procedures explain how to erase all 
existing data on the server and reinstall the 
operating system.

a CallPilot system that is already in 
operation and backup tapes are 
available

follow the steps in “Recovering from a hard 
drive failure” on page 145.
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Reinstalling languages

Introduction

If only the language prompts are not functioning, then you can reinstall languages to 
try to fix the problem.

Requirements

To reinstall languages, you need the CallPilot Language CD-ROM.

To reinstall languages

1 Log on to the CallPilot server.

2 Run the Configuration Wizard.

3 See steps 13 to 25 in “To reinstall the CallPilot server software” on page 140.

ATTENTION
If you encounter problems when reinstalling the language 
prompts, contact your Nortel Networks customer support 
representative.
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Recovering from corrupted software (hard drive 
is functioning)

Introduction

If the hard drive is functioning but the CallPilot software appears to be corrupted, 
you can reinstall the CallPilot server software. This might correct the problem. If it 
does not correct the problem, then you need to rebuild the hard drive (see 
“Recovering from a hard drive failure” on page 145).

The reinstallation procedure copies CallPilot program files from the CallPilot Server 
CD-ROM to a CallPilot system running the same version of CallPilot software as on 
the CD-ROM. This process does not affect system or user data. It neither removes 
nor corrects any system data or information. It recovers most CallPilot program files, 
but not the operating system, service pack, or, in the case of non-Meridian 1 systems, 
switch drivers.

Requirements

To recover from corrupted software, you need the following items:

■ the CallPilot Server CD-ROM that has the same version of CallPilot that is 
running on the CallPilot server

■ the CallPilot Language CD

■ the PEP CD

To reinstall the CallPilot server software

Note: During the reinstall, the following message might appear. If this message 
appears, click OK and continue with the reinstall: 

1 Log on to the CallPilot server.

2 Insert the CallPilot Server CD-ROM.

ATTENTION
If you encounter problems when reinstalling the CallPilot 
software, contact your Nortel Networks customer support 
representative.
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3 Run setup.exe from the root directory of the CallPilot Server CD-ROM.

Result: The following message appears:

4 Click Yes.

Result: If there are any PEPs on the system, the following message appears:

5 Click OK to uninstall PEPs.

Result: The first PEP is uninstalled. 

6 If there are more PEPs installed, the dialog box shown in step 4 appears again. 
For each PEP installed on the server, this dialog box appears. Each time, click 
OK to continue.

Result: After all PEPs have been uninstalled, a dialog box appears showing the 
PEPs that have been uninstalled.
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7 Click OK.

Result: Files are copied to the server as part of the reinstall procedure. This 
can take up to 10 minutes. This is followed by a dialog box prompting to reinstall 
PEPs (if any were present on CallPilot).

8 Insert the PEP CD-ROM.

9 Click OK to reinstall PEPs.

10 Follow the wizard instructions for installing the PEPs.

11 After all PEPs are reinstalled, restart the server when prompted.

12 After CallPilot has restarted, run the Configuration Wizard.

See Part 3 of this binder for instructions.

13 Leave all current values in the Configuration Wizard dialog boxes as they are 
until you reach the Language Source Directory dialog box shown here:

14 Insert the CallPilot Language CD.

15 Select Install Language.

16 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files on 
the CD. For example, if the CD-ROM is drive Z:, just select Z:.
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17 Click Next.

Result: The following dialog box appears, which lists all currently installed 
languages:

18 Select all the languages listed, and then click Next. 

Result: The Add Prompt Language dialog box appears.

19 Click Next to skip this dialog box.

Result: The Primary and Secondary Languages dialog box appears.

20 Click Next to accept the currently assigned primary and secondary languages.

Result: The Speech Recognition Languages dialog box appears.

21 Click Next to skip this dialog box.

Result: The language installation dialog boxes are completed.
Part 5: 201i Server Maintenance and Diagnostics 143



Recovering from corrupted software or a hard drive failure  Standard 1.0
22 Click Next through the remaining Configuration Wizard dialog boxes until the 
following dialog box appears:

23 Select Apply the current configuration, and then click Next.

Result: The configuration changes are applied to the server. This is followed by 
a prompt to restart to CallPilot. 

Note: The configuration changes take approximately 10 minutes, plus an 
additional 10 minutes for each language you are reinstalling. 

24 Click Finish. Then click OK to restart CallPilot.

Result: The CallPilot software reinstallation is done. 

25 Test your CallPilot channels as described in Part 4 of this binder.
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Recovering from a hard drive failure

Introduction

If this is a CallPilot system that is already in operation and backup tapes are 
available, then follow the steps in this section.

If this is a new CallPilot system (for example, the system failure occurs before or 
during CallPilot installation), then follow the steps in “Installing the operating 
system and server software” on page 147.

Requirements

To recover from a hard drive failure, you need the following items:

■ all software media that came with the CallPilot system:

■ Windows NT 4.0 OS Recovery CD-ROM

■ Application Server Driver CD-ROM

■ CallPilot Server CD-ROM

■ CallPilot PEP CD-ROM

■ a system backup (if available)

To recover from a hard drive failure

1 Replace the faulty hard drive. 

See “Replacing the IDE hard drive” on page 120.

2 Follow the procedures in “Installing the operating system and server software” 
on page 147.

3 Configure the CallPilot server software. Follow the steps in Part 3 of this binder.

4 Log on to the CallPilot server as Administrator or any account that has local 
administrative privileges.

5 Insert the system backup tape.

6 Click Start > Programs > CallPilot > System Utilities > Support Tools.

7 Start up Tool Launcher.

8 Log on with the appropriate user ID to display the main menu.

9 Select Sysops Utilities from the main menu to display the Systems Operations 
Utilities menu.

ATTENTION
If you encounter problems when recovering from a hard drive 
failure, contact your Nortel Networks technical support 
representative.
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10 Select Backup/Restore Command Line Utility to launch the restore utility.

Result: The message Wait, Tool is launching...Done appears once 
the system launches the Backup/Restore utility.

11 At the CI> prompt, type listtape, and then press Enter to display a catalogue of 
all files on the backup tape.

Result: The system displays the prompt, “Device name: <Max. Len. = 100>:”. 

12 Type the name of the device from which the backup is to be restored, and then 
press Enter.

Result: The system displays the backup directory for the device.

13 Type startrestore, and then press Enter.

Result: The system displays the prompt, “Device name: <Max. Len. = 100>:”.

14 Enter the name of the device from which the backup is to be restored, and then 
press Enter.

Result: The system displays the prompt, “Backup ID:”.

15 Enter the entire backup file name, including the timestamp, as displayed in Step 
12.

Result: The system begins to restore the data from the backup tape to the 
system.

16 At the CI> prompt, type status, and then press Enter.

Result: The system displays the progress of the restore process, including the 
number of items, file size restored, and time to completion.

17 When the status shows as “Completed,” press Enter to return to the CI> prompt 
on the main menu.

18 Remove the system backup tape.

19 Select Start > Shut Down, and then select Restart to restart the restored 
system.
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Overview

Introduction

This chapter discusses how to install the CallPilot server software on a system that 
does not have backups and requires an install from scratch. The procedures here are 
also used to recover from a hard drive failure. (For additional information, see 
“Recovering from corrupted software or a hard drive failure” on page 137.)

Hardware and software requirements

You need the following items to perform a hard drive recovery and build:

■ local SCSI CD-ROM drive

■ appropriate SCSI cabling

■ Windows NT 4.0 OS Recovery CD-ROM

■ Application Server Driver CD-ROM

■ CallPilot Server CD-ROM

■ PEP CD-ROM

■ Language Prompts CD-ROM set (3)

Note: You need the Language Prompts CD-ROMs when running the 
Configuration Wizard to configure CallPilot (see Part 3 of this binder).

Process overview

This chapter explains how to do the following:

1. Boot to ROM-DOS.

2. Erase and partition the hard drive.

3. Reformat the partition.

4. Prepare to install Windows NT from the CD-ROM via ROM-DOS.

5. Install Windows NT Server 4.0 and Service Pack Upgrade.

6. Configure Windows NT.

7. Install pcANYWHERE32 and CallPilot server software.

8. Install Performance Enhancement Packages (PEPs).
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Load ROM-DOS

The first step in performing a hard drive build or recovery is to boot into ROM-DOS 
and select the Windows NT install options from the ROM-DOS menu.

Erase, and then partition the hard drive

Before you can install Windows NT, the hard drive must be erased of all data, 
followed by a disk format. If applicable, ensure all data is backed up prior to 
committing to this procedure.

You require a minimum of 1 Gbyte for the Windows NT files.

Install Windows NT Server 4.0

Windows NT is the operating system on which the 201i server software runs.

The Windows NT installation is virtually a hands-free installation because most of 
the Windows NT settings have been predetermined. After you start the installation 
and respond to the preliminary prompts, the majority of the remaining steps install 
automatically.

The system prompts you to enter the Windows NT 4.0 serial number and server 
computer name. Remote Access Service (RAS) and Windows NT Service Pack 
Upgrades are installed automatically.

Configure Windows NT

For correct operation with CallPilot, you must do the following in Windows NT:

1. Create partition drive D: as NTFS.

2. Install network adapters and drivers for the SCSI device and tape drive.

3. Configure the network services and addresses.

4. Optimize network bindings.

5. Configure the correct date and time.

6. Configure virtual memory.

7. Disable debugging information dump file creation.

8. Install the tape drive driver.

9. Remove the old SCSI device driver and install the new one.
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Install pcANYWHERE32

pcANYWHERE32 enables your distributor or your Nortel Networks technical 
support representative to dial in to the server to provide product support.

Install CallPilot server software

Once you have completed installing the operating system, you can install the 
CallPilot server software.

Install Performance Enhancement Packages

Performance Enhancement Packages (PEPs) are provided on CD-ROM. You must 
install PEPs in a specific order as identified in the readme files on the PEP 
CD-ROM. 
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Booting to ROM-DOS

Introduction

ROM-DOS is a read-only disk operating system that resides on the 201i server. You 
do not have to install it. It is currently defined as drive A and is only accessible when 
you select it during the 201i server startup.

When you boot the 201i server to ROM-DOS, you can perform the following tasks:

■ View the contents of the hard drive using standard DOS commands.

■ Access the CD-ROM.

■ Partition and reformat the hard drive.

■ Install Windows NT using the SCSI CD-ROM drive.

To boot to ROM-DOS

1 After you insert the 201i server in the switch, restart it using any of the following 
methods:

a. Press the faceplate reset button.

b. Simultaneously press the Ctrl+Alt+Delete keys.

c. Shut down and restart Windows NT.

Result: Once executed, the 201i server begins to boot. The bootup sequence 
is very similar to a PC bootup, in that it initalizes the memory count and detects 
the mouse and hard drive.

After the initial bootup screen, the server clears the screen and asks if you want 
to boot into ROM-DOS:

CallPilot 201i Nortel Networks (c) 2000
Option ROM Build from 07/13/00 15:43:44

Boot ROM-DOS (Default: No after 5 secs.)(Y/N)?

ATTENTION
ROM-DOS is a read-only version of DOS. Therefore, you 
cannot write to drive A (for example, copy files) while running 
ROM-DOS.

ATTENTION
If you do not press Y within five seconds, an error message 
appears. Press Ctrl+Alt+Delete again. When you see “Boot 
ROM-DOS (Default: No after 5 seconds.) (Y/N)?” on the 
screen, press Y.
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2 Press Y.

Result: A ROM-DOS startup menu appears as follows. This menu is used for 
file transfer and to assist you with Windows NT installation:

Note: Option 2: CLAN NETWORK is reserved for Nortel Networks CallPilot 
Product Support applications.

3 Continue with “Displaying the Windows NT installation menu from ROM-DOS” 
on page 153.

1. SCSI CD-ROM

2. CLAN NETWORK

3. WINNT INSTALLATION
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Displaying the Windows NT installation menu 
from ROM-DOS

Introduction

The Windows NT installation menu provided in ROM-DOS allows you to erase the 
hard drive, create a DOS partition, format the hard drive, and perform the Windows 
NT installation.

To display the menu

1 Type 3 and press Enter for WINNT INSTALLATION.

Result: A submenu appears as follows: 

2 Continue with “Erasing the hard drive” on page 154.

1. ERASE HARD DRIVE

2. CREATE DOS PARTITION

3. FORMAT HARD DRIVE

4. WINNT INSTALLATION VIA CD-ROM
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Erasing the hard drive

Introduction

Before you can partition the hard drive, ensure all valid data has been backed up (if 
applicable). 

To erase the hard drive

1 From the WINNT installation submenu, type 1 and press Enter for ERASE 
HARD DRIVE. 

Result: The 201i server erases the contents of the hard drive. When 
completed, the server automatically restarts.

2 When the system prompts you for ROM-DOS, press Y.

3 Type 3 and press Enter to continue with the Windows NT installation.

4 Continue with “Partitioning the hard drive” on page 155.
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Partitioning the hard drive

Introduction

The next step in performing a hard drive build or recovery is to partition the hard 
drive. 

To create a new partition

1 From the WINNT installation submenu, type 2 and press Enter for CREATE 
DOS PARTITION. 

Result: A 1 Gbyte partition is created.

2 When the ROM-DOS prompt appears, press Y.

3 Type 3 and press Enter to continue with the Windows NT installation.

4 Continue with “Formatting the new partition” on page 156.
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Formatting the new partition

Introduction

This section describes how to format the partition you just created using the FAT file 
system.

To format the new partition

1 From the WINNT installation submenu, type 3 and press Enter for FORMAT 
HARD DRIVE. 

Result: You are asked if you want to proceed. 

2 Type Y and press Enter to delete all contents of the hard drive.

Result: When the drive format is completed, the server automatically restarts.

3 When you are prompted for ROM-DOS, press Y.

4 Type 3 and press Enter to proceed to WINNT installation.

5 Continue with “Installing Windows NT from the CD-ROM” on page 157.
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Installing Windows NT from the CD-ROM

Introduction

At this stage of the recovery process, you are ready to install the operating system. 
The Windows NT 4.0 OS Recovery CD-ROM contains special software to allow for 
a minimal number of user inputs, and automatic installation of the Remote Access 
Service (RAS) and Windows NT Service Pack Upgrade.

You need the following information before you can install Windows NT:

■ Windows NT OEM serial number

■ 201i server’s network computer name

Post-Windows NT installation requirements are described later in this section.

Before you begin

1 Review this section and ensure that you have all the information you need to 
complete the installation.

2 Ensure that the CD-ROM drive is connected to the 201i server before the server 
is powered on. If the CD-ROM is not connected, do the following:

a. Power off the 201i server by removing the server from the switch.

b. Attach the CD-ROM drive.

c. Power up the CD-ROM drive.

d. Reinsert the server into the switch.

e. Boot to ROM-DOS by selecting Y when prompted during initial bootup (see 
page 151).

ATTENTION
If an error occurs during the installation (for example, a SCSI 
cable is accidentally removed, or power is lost), erase the 
hard drive, reformat it, and then install Windows NT again.
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To install Windows NT from the CD-ROM

1 From the WINNT installation submenu, press 4 for WINNT INSTALLATION VIA 
CD-ROM.

Result: When the script is executed, the CD-ROM drivers are loaded and you 
are prompted to ensure that the Windows NT 4.0 OS Recovery CD-ROM is 
properly placed in the CD-ROM drive. 

2 Press any key to continue. 

Result: Windows NT begins to install automatically.

Note: A delay of approximately 15 seconds is needed to allow for the CD-ROM 
spinup and to initialize the newly inserted CD-ROM. 

If the CD-ROM drive is not ready, you might receive a CDR101 error message. 
Ensure the correct CD-ROM is in the drive and that the SCSI cable is 
connected and powered on. Press R to retry the operation. If the installation 
fails repeatedly, power off the server, examine all of the connections, and retry 
the installation.

3 When the Windows NT Server Setup dialog box titled Registration appears, 
enter the Windows NT OEM serial number in the Product ID box, and then 
press Enter.

4 When the Windows NT Server Setup dialog box titled Computer Name 
appears, enter the server’s network computer name in the Name box, and then 
press Enter.

5 When the Windows NT Server Setup dialog box titled Windows NT Setup 
appears, press Enter.

6 Continue with the installation as described in “Configuring Windows NT Server 
4.0” on page 159.

ATTENTION
During Windows NT installation, a number of automatic 
reboots occur. During these reboots, do not start ROM-DOS. 
The ROM-DOS installation portion is now complete. The last 
reboot is evident by a 60-second mandatory reboot to allow for 
Windows NT Service Pack upgrades to take effect.
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Configuring Windows NT Server 4.0

Introduction

After the Windows NT installation is complete, you must perform the following 
tasks to ensure correct operation of Windows NT with CallPilot:

1. Create partition drive D as NTFS (see page 160).

2. Install network adapter, SCSI device, and tape drive drivers (see page 165).

3. Configure the network services and addresses (see page 166).

4. Configure the correct date and time (see page 180).

5. Configure virtual memory (see page 181).

6. Install the tape drive driver (see page 184).

7. Remove the old SCSI device driver and install the new one (see page 186).

Logging on

When Windows NT has completed the installation, you are presented with the Begin 
Logon dialog box that prompts you to press Ctrl+Alt+Delete to log on. You must log 
on as Administrator and complete the post-installation tasks described in this 
section.

Notes: 

■ For the initial installation of Windows NT, the Administrator password is not 
defined.

■ After you log on, Windows NT displays a Welcome dialog box. For more 
convenience, click the “Show this Welcome screen next time you start Windows 
NT” check box to remove the check mark, and then click Close.
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Creating the drive D NTFS partition

Introduction

This section explains how to create the drive D NTFS partition.

To create the drive D NTFS partition

1 Click Start > Programs > Administrative Tools (Common) > Disk Administrator.

Result: Disk Administrator prompts you to update the System Configuration 
utility. 

2 Click OK.

Result: Windows NT identifies the drive as being new and asks for permission 
to create a signature on the hard drive.

Note:  If Windows NT was previously installed, the hard drive signature already 
exists. Therefore, this window does not appear.
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3 Click Yes.

Result: The Disk Administrator window similar to the following appears:

Before you can create a new partition, you must change the CD-ROM drive 
letter to drive Z. This releases drive letter D, which will be used to create the 4 
Gbyte NTFS partition.

4 Highlight the white square labeled “D” and right-click.

5 Select Assign Drive Letter, and then reassign to drive Z.

6 Click OK, and then click Yes to implement the changes immediately. 

The following window is a completed example:
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7 Right-click the diagonally lined box labeled “Free Space” beside Disk 0.

Result: A pop-up menu appears.

8 Select Create.

Result: A confirmation message appears.

9 Click Yes. 

10 Create a partition of 4000 Mbytes (4.0 Gbytes). 

The following dialog box is an example:

11 Click OK.

Result: You are returned to the Disk Administrator window.

The next step is to format the new partition to NTFS.

12 Right-click the white box for drive D.

Result: A pop-up menu appears.
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13 Select Commit Changes Now. 

Result: A confirmation window appears.

14 Click Yes.

Result: The Disk Administrator responds by stating that your changes were 
successful.

15 Click OK.

16 Right-click the white box for drive D again.

17 From the pop-up menu, select Format. 

Result: The Format dialog box appears:

18 Ensure that NTFS is selected in the File System list.

19 Click Start.

Result: A warning message appears.

20 Click OK.

Result: Drive formatting begins and takes approximately 5 minutes to 
complete. 
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21 When drive formatting is completed, click OK and then click Close to exit the 
Format D: dialog box.

Result: The Disk Administrator window resembles the following:

22 Click Partition > Exit to leave Disk Administrator.

23 Continue with “Installing device drivers” on page 165.
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Installing device drivers

Introduction

The Application Server Driver CD-ROM contains all hardware-related drivers for 
the 201i server (such as Ethernet, SCSI device, tape drive, and so on). This section 
explains how to install the drivers.

To load the 201i device drivers from the Application Server Driver 
CD-ROM

1 Remove the Windows NT 4.0 OS Recovery CD-ROM from the CD-ROM drive 
and insert the Application Server Driver CD-ROM.

The CD-ROM contains all hardware-related drivers for the 201i server (such as 
Ethernet, SCSI device, tape drive, and so on). 

Result: The application launches automatically.

2 The system prompts you to ensure that you are using a 20xi server.

3 Press Y.

4 Navigate to CallPilot Tools.

5 Press Enter.

Result: A submenu appears displaying the different platforms.

6 Select 201i.

7 Press Enter.

8 Press Enter to copy the drivers to the hard drive.

Result: The program prompts you if you want to continue.

9 Click Y for yes.

Result: The target directory is shown as c:\201TMP\<drivers>.

10 Click any key to continue.

Result: Once the installation is complete, the Drivers copied message 
appears.

11 Press any key to continue.

Result: The 201i menu appears.

12 Click ESC three times to exit the program.

13 Remove the Application Server Driver CD-ROM from the CD-ROM drive.

14 Continue with “Configuring the network interface” on page 166.
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Configuring the network interface

Introduction

This section describes how to configure the following elements:

■ network services

You must remove the MS Internet Server because it is not used by CallPilot.

The unattended Windows NT installation installs Remote Access Service with a 
generic IP configuration. You must configure the settings to your organization’s 
specifications.

■ network adapters

The MS Loopback Adapter is a dummy adapter used during the unattended 
installation of Windows NT. Its presence is not required by CallPilot and can be 
deleted at this time.

Your 201i server has two embedded Ethernet adapters. This section explains 
how to install and configure both network adapters.

■ network addresses

To establish connectivity between CallPilot, the switch, and your network, you 
must enter the CallPilot server’s IP address, subnet mask, and default gateway.

You must also enter the WINS servers’ IP addresses, domain name, DNS 
service search order, and domain suffix search order information for your 
network infrastructure.

To remove MS Internet Server

You must remove the MS Internet Server because it is not used by CallPilot.

1 Click Start > Settings > Control Panel.

2 Double-click the Network icon.

Result: The Network dialog box appears.
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3 Click the Services tab.

Result: The Services tab appears.

4 Select Microsoft Internet Information Server 2.0, and then click Remove.

Result:  Windows NT prompts you to confirm the change.
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5 Click Yes.

Result: Once the change is completed, the Services tab should resemble the 
following:

6 Continue with “To configure the Remote Access Service” on page 169.
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To configure the Remote Access Service

The unattended Windows NT installation installs Remote Access Service with a 
generic IP configuration. You must configure the settings to your organization’s 
specifications.

1 On the Services tab, select Remote Access Service, and then click Properties.

Result: The Remote Access Setup dialog box appears.

2 Click Network.

Result: The Network Configuration dialog box appears.

3 Ensure that TCP/IP is checked, and then click Configure.

Result: The RAS Server TCP/IP Configuration dialog box appears.
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4 Change the default IP settings according to your site requirements.

The following dialog box provides an example:

5 Click OK twice.

6 Click Continue.

Result: The Network dialog box reappears.

7 Continue with “To remove the MS Loopback Adapter” on page 171.
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To remove the MS Loopback Adapter

The MS Loopback Adapter is a dummy adapter used during the unattended 
installation of Windows NT. CallPilot does not require its presence; therefore, it can 
be deleted at this time.

1 Click the Adapters tab.

Result: The Adapters tab appears.

2 Select [1] MS Loopback Adapter, and then click Remove.

Result: A warning pop-up window appears.
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3 Click Yes.

Result: After the adapter is removed, the network dialog box resembles the 
following example:

4 Continue with “To install the 10/100 Base-T network interface adapters” on 
page 172.

To install the 10/100 Base-T network interface adapters

1 On the Adapters tab, click Add. 

Result: The system prompts you for the source files for the network adapter 
cards.

2 Click Have Disk, and then type the following as the path:

c:\201tmp\network\intel
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3 Press Enter.

Result: The following dialog box appears:

4 Click OK.

Result: When the adapter is installed, it appears twice in the list, similar to the 
following example:

The CLAN is always defined as the first Intel network adapter and is 
represented as [1]. The ELAN is the second Intel network adapter and is 
represented as [5].
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5 Click Close.

6 Continue with “To configure the network addresses” below.

To configure the network addresses
To establish connectivity between CallPilot, the switch, and your network, you 
must enter the CallPilot server’s IP address, subnet mask, and default gateway, 
as well as the WINS servers’ IP addresses, domain name, DNS service search 
order, and domain suffix search order information for your network 
infrastructure.

Note: The CLAN is the first Intel network adapter and is represented as [1]. 
The ELAN is the second Intel network adapter and is represented as [5].

1 On the Microsoft TCP/IP Properties dialog box, do the following for each of the 
CLAN and ELAN network adapters: 

a. Select the network adapter you want to configure from the Adapter list box.

b. Enter the following information according to your network infrastructure:

■ IP Address (for example, 1.1.1.1)

■ Subnet Mask (for example, 255.255.255.0)

■ Default Gateway

2 Click the DNS tab.

Result: The DNS property page appears.
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3 Enter the domain name, DNS service search order, and domain suffix search 
order information for your network infrastructure. 

4 Click the WINS Address tab.

Result: The WINS Address property page appears.

5 Enter the IP addresses for the primary and secondary WINS servers. Ensure (if 
applicable) that the WINS server IP addresses are entered for both Ethernet 
adapters.

6 Click OK at the bottom of the Network dialog box.

Result: Windows NT prompts you to restart the server to allow the changes to 
take effect.

7 Click Yes.

8 Once the system has restarted, press Ctrl+Alt+Delete and log on again.

9 Continue with “Configuring the date and time” on page 180.
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Optimizing the network bindings

Introduction

This section explains how to optimize the network bindings. Network bindings tell 
the 201i server the order in which to find information on the network.

Note: If, at a later time, you add or replace the CLAN adapter, you must readjust the 
binding order.

To configure the network bindings

1 Click Start > Settings > Control Panel.

2 Double-click the Network icon. 

Result: The Network dialog box appears.

3 Click the Bindings tab.

Result: The Bindings property page appears.

4 Configure the NetBIOS Interface service group as follows:

a. Expand the NetBIOS service group by clicking the plus sign (+) beside 
NetBIOS Interface.

b. Expand the WINS client (TCP/IP) group by clicking the plus sign (+).
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c. Click each adapter, and then click Move Up or Move Down to sort the list 
into the following order: 

■ CLAN adapter

■ ELAN adapter

■ RAS adapter.

d. Collapse the NetBIOS Interface service group by clicking the plus sign (+).

5 Repeat the procedure described in step 4 to configure the Remote Access 
Server Service group into the following order:

■ RAS adapter

■ Adapter configured for the RAS pool

■ ELAN adapter
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6 Repeat the procedure again to configure the Server service group into the 
following order:

■ ELAN adapter

■ CLAN adapter
178 CallPilot



October 2000            Installing the operating system and server software
7 Repeat the procedure again to configure the Workstation service group into the 
following order:

■ ELAN adapter

■ CLAN adapter

8 Click OK.

Result: Windows NT prompts you to restart the server to allow the changes to 
take effect.

9 Click No.

10 Continue with “Configuring the date and time” on page 180.
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Configuring the date and time

Introduction

This section explains how to configure the system date and time.

To configure the date and time

1 Click Start > Settings > Control Panel.

2 Double-click the Date/Time icon.

Result: The Date & Time Properties dialog box appears.

3 Enter the correct date and time.

4 Click the Time Zone tab.

Result: The Time Zone property page appears.

5 Select the time zone for your geographical area.

Example: (GMT -05:00) Eastern Time (US & Canada) 

Note: During installation, Eastern Time is defined as the default. Select the 
time zone for your region.

6 Ensure the check box for “Automatically adjust clock for daylight saving 
changes” is checked.

7 Click OK.

8 Continue with “Configuring virtual memory and system recovery settings” on 
page 181.
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Configuring virtual memory and system 
recovery settings

Introduction

This section explains how to

■ configure virtual memory

■ disable debugging information dump file creation to conserve disk space

To configure virtual memory

1 Click Start > Settings > Control Panel.

2 Double-click the System icon. 

3 Click the Performance tab. 

Result: The Performance property page appears.
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4 In the Virtual Memory section, click Change. 

Result: The Virtual Memory dialog box appears.

5 Type 268 in the Initial Size (MB) and Maximum Size (MB) boxes.

6 Click Set to commit the changes.

7 Click OK.

8 Continue with “To disable debugging information dump file creation” on page 
183.
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To disable debugging information dump file creation

1 Click the Startup/Shutdown tab.

Result: The Startup/Shutdown property page appears.

2 Click the “Write debugging information to” check box to remove the check mark.

3 Click Apply, and then click OK.

Result: The System Setting Change dialog box appears informing you that a 
restart is necessary for changes to take effect.

4 Click OK to restart the server.

5 Once the system has restarted, press Ctrl+Alt+Delete and log on again.

6 Continue with “Installing the tape drive and SCSI device drivers” on page 184.
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Installing the tape drive and SCSI device drivers

Introduction

After Windows NT has restarted, you must install the tape drive driver. The tape 
drive is used to perform backups of the CallPilot system databases.

You must remove the existing SCSI driver and replace it with the updated driver.

To install the tape drive driver

1 Click Start > Settings > Control Panel.

Result: The Control Panel appears.

2 Double-click the Tape Devices icon.

3 Click the Drivers tab.

4 Click Add.

Result: The list of available tape drive device drivers similar to the following 
example appears:

5 Click Have Disk.

Result: The system prompts you to insert the manufacturer’s installation disk.
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6 Type c:\201tmp\tape as the path.

7 Click OK.

Result: The system prompts you to select a device driver from the displayed list 
similar to the following example:

8 Select Seagate tandqic (Tandberg Data QIC SCSI drives, all).

9 Click OK.

Result: The system prompts you for the path to the OEM Tape Device files.

10 Type c:\201tmp\tape as the path, and then click Continue.

Result: The driver files are copied to the system. 

11 Click OK twice to exit the window.

Note: If there is no tape drive attached to the CallPilot system after you install 
the tape drive driver and you have restarted the system, a Service Control 
Manager warning message might appear that says At least one service 
or driver failed during system startup. Use Event Viewer to 
examine the event log for details. You can ignore this message. 
Click OK and continue to the next step.

12 Continue with “To install the updated SCSI device driver” on page 186.
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To install the updated SCSI device driver

1 Click Start > Settings > Control Panel.

Result: The Control Panel appears.

2 Double-click the SCSI Adapters icon.

3 Click the Drivers tab.

Result: The SCSI Adapters dialog box similar to the following example 
appears:

4 Select the Symbios Logic C810 driver, and then click Remove.

Result: The system prompts you to confirm the change.
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5 Click Yes. 

Result: The SCSI Adapters dialog box now resembles the following example:

6 Click Add.

Result: Windows NT displays a list of SCSI adapter drivers similar to the 
following example:
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7 Click Have Disk.

8 Type c:\201tmp\ntscsi\winnt\miniport as the path.

Result: The system prompts you to insert the manufacturer’s installation disk.

9 Click OK.

Result: The system prompts you to select a device driver from the displayed list 
similar to the following example:

10 Click OK.

Result: The system prompts you for the path to the OEM SCSI Device files.
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11 Type c:\201tmp\ntscsi\winnt\miniport as the path.

12 Click Continue.

Result: The driver files are copied to the system. The system prompts you to 
restart Windows NT to allow the changes to take effect.

13 Select Yes.

Result: The server restarts.

What’s next?

Install pcANYWHERE32.
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Installing pcANYWHERE32

Introduction

The process of installing pcANYWHERE32 involves the following procedures:

1. Install the pcANYWHERE32 application on the server (see below).

2. Start pcANYWHERE32 for the first time. 

This procedure allows you to set the network device (see page 196). 

3. Set the video mode (see page 198). 

This procedure synchronizes the video card settings with that of the 
administration client PC to ensure the remote user can see the server graphical 
user interfaces properly. 

4. Install pcANWHERE32 patches (see page 200).

5. Configure pcANWHERE32 (see page 201).

6. Set the pcANYWHERE32 service to Automatic (see page 204). 

This procedure enables the pcANYWHERE32 service to start automatically 
after reboot. 

To install pcANYWHERE on the server

1 Log on as administrator.

2 Insert the MAS 2.0 Operating System CD-ROM into the CD-ROM drive.

3 Ensure all other Windows applications are closed.

4 Navigate to the Installs\Pca32\Disk1 folder on the CD-ROM drive as follows:

a. Double-click Installs.

b. Double-click Pca32.

c. Double-click Disk1.

d. Locate and double-click the Setup application file.

Result: The Welcome to pcANYWHERE setup program window appears.
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5 Click Next to start the installation.

Result: The User Information window appears.
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6 Enter the user name and company name, and then click Next.

Note: Ensure that the company name is the same as the one entered during 
the Windows NT installation.

Result: The Online License Agreement window appears.

7 Click Yes to accept the software license agreement.

Result: The Choose Destination Location window appears.

8 Click Browse, and then change the directory to d:\pcANYWHERE.

Note: You might be warned that the directory does not exist and asked if you 
want to create it. Click Yes.

Result: The Choose Destination Location window reappears with the revised 
directory path.
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9 Click Next.

Result: The Setup Review window appears.

10 Click Next to continue.

Result: Program and other files are copied to the system.

When installation is complete, the Symantec Support Solutions window 
appears.
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11 Click Next to display the How To Reach Us window.

12 Click Next to continue.

Result: The Windows 95 Solutions window appears.
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13 Click Next to continue.

Result: The Registration Wizard window appears.

14 Click Skip.

Result: The system asks if you want to view the README file now.
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15 Click No.

Result: Setup prompts you to restart the computer.

16 Click No, I will restart my computer later, and then click Finish.

Result: pcANYWHERE32 setup terminates.

To start pcANYWHERE32 for the first time

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

Result: The Smart Setup Wizard window appears, and the system prompts you 
for the modem device.
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2 Ensure that the Standard 28800 bps Modem is selected, and then click Next.

Result: The system prompts you to select the network device.

3 Ensure that only TCP/IP is selected, and then click Next.

Result: The system prompts you to select a port.
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4 Ensure that you select COM1, and then click Finish.

Result: The pcANYWHERE32 window appears.

To set the video mode

1 On the File menu, click Application Options.

Result: The Location Information dialog box appears.
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2 Select your country from the Country list.

3 Type your area code into the Area Code box.

4 Click Close.

Result: The Application Options dialog box appears.

5 Click the Host Operation tab.

Result: The Host Operation property page appears.

6 In the Video mode selection drop-down list, select Default—Accelerator 
Enabled, and then click Apply.

Note: If the Video mode selection is already defined as Default—Accelerator 
Enabled, the Apply button is dimmed. Click OK to close the window and go to 
step 8.

7 Click OK to close the window.

Result: The pcANYWHERE32 window appears.

8 To finish the installation, click File > Exit.

9 If you performed the installation from the CD-ROM drive, remove the CD-ROM 
from the drive.
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To perform the pcANYWHERE32 patch installation
Note: The pcANYWHERE32 patches are located on the CallPilot Server 
CD-ROM in the following directory: platform\default\nortel\data\PCANYW_1.

1 Insert the CallPilot Server CD-ROM.

2 Install the 802up_a Patch. 

Navigate to platform\default\nortel\data\PCANYW_1\802up_a\disk1, and then 
double-click the setup.exe icon. 

Result: The Welcome window appears.

3 Click Next. 

Result: The Start Copying Files window shows the path for copying files.

4 Click Next. 

Result: Setup copies files to the directories, and then the Setup complete 
window appears.

5 Select No, I will restart my computer later, and then click Finish.

Note: Do not restart the computer. Continue with installing the next patch.

6 Install the 802up_b Patch. 

Navigate to platform\default\nortel\data\PCANYW_1\802up_b, and then 
double-click setup.exe.

Result: The Welcome window appears.

7 Click Next. 

Result: The Start Copying Files window appears, showing the path for copying 
files.

8 Click Next. 

Result: Setup copies files to the directories, and then the Setup Complete 
window appears.

9 Select No, I will restart my computer later. 
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10 If you see the following screen, ensure the check box is unchecked, and then 
click Finish: 

11 Restart the computer by clicking Start > Shutdown. Select Restart the 
Computer, and then click OK.

To configure pcANYWHERE32

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

2 Select Be a Host PC.

3 Right-click the Network icon, and then click Properties.

Result: The NETWORK Properties sheet appears.

4 Click the Connection Info tab.

5 Ensure that only TCP/IP is checked.
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6 Click the Settings tab and select the Launch with Windows check box. Ensure 
that the settings are as shown in the following example:

7 Click the Callers tab.

8 Click Specify individual caller privileges, as in the following example:

9 Double-click Add Caller.

Result: The New Caller Wizard window appears.
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10 Type CallPilotDist and click Next.

11 Type CallPilotDist for the logon name.

12 In the Password box, type the new CallPilotDist password.

13 In the Confirm Password box, retype the new CallPilotDist password.

14 Click Next.

15 Click Finish.

Result: The Network Properties sheet appears.

16 Click the Security Options tab and select the check boxes for the following 
entries:

■ Log failed connection attempts

■ Make passwords case-sensitive

■ Deny lower encryption level

17 Ensure that the settings are as shown in the following example:

18 If you want to assign a password to control who can modify the Network icon 
settings, click the Protect Item tab, and then enter a password. 

19 Click OK to apply all pcANYWHERE32 settings.
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To set the pcANYWHERE32 service to Automatic

1 Click Start > Settings > Control Panel.

2 Double-click Services.

3 Scroll to pcANYWHERE Host Service, and highlight the service.

4 Click Startup.

Result: The Service dialog box appears.

5 In the Startup Type area, select Automatic.

6 Click OK.

7 Close the Services window, and exit the Control Panel.

What’s next?

Install the CallPilot server software.
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Installing CallPilot server software

Introduction

This section describes the steps required to install CallPilot software on a CallPilot 
server that is already loaded with the Windows NT 4.0 operating system and the 
device drivers required by CallPilot.

Requirements

To install the CallPilot server software, you need the following:

■ CallPilot 1.07 Server CD-ROM

■ CallPilot 1.07 PEP CD-ROM

■ a server that is powered on, with Windows NT 4.0, Service Pack 5, and all the 
device drivers installed

■ the current password for the Administrator account

Note: This password was set during the installation of Windows NT.

To install the CallPilot server software

1 Insert the CallPilot 1.07 Server CD-ROM into the CD-ROM drive and launch 
Windows NT Explorer.

2 Click the CD-ROM drive, and then double-click setup to start the CallPilot 
installation. 

Result: The Nortel System Operations window appears.

ATTENTION
During an installation, there are stages during which the setup 
program performs automatic installation steps between setup 
windows. Do not close any windows that appear during these 
steps unless you are prompted. Wait for the next wizard setup 
window before you use the mouse or keyboard. 
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3 Click Next. 

Result: You are asked to confirm the installation of CallPilot files onto your PC. 

4 Click Yes.

Result: You are prompted to start the platform setting procedure. 

5 Click Yes.

Result: The Platform Type Information Test Application window appears.
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6 Type 1 to set the platform type, and then press Enter.

Result: The system prompts you to identify the machine class.

7 Type 2 for IPE.

Result: The system prompts you to identify the machine type.

8 Type 3 for IPE.

Result: The system prompts you to identify the platform series.

9 Type 1, and then press Enter.

Result: The Select the backplane type prompt appears.

10 Type 1 for Active.

Result: The Nortel System Operations window appears and shows the current 
platform settings based on your responses.

11 If the settings are correct, click Yes to initiate the installation. Otherwise, click 
No to rerun the platform setting procedure.

Result: The installation setup process runs automatically (taking 15 to 30 
minutes). A series of messages appears to indicate the items that are being 
installed (for example, backup/restore, MMFS). 
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When installation is complete, the following dialog box appears:

12 Click OK.

13 Remove the Server CD-ROM. 

What’s next?

If you have a PEP CD-ROM, install the PEPs. 
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Installing Performance Enhancement Packages

Introduction

For an initial installation of CallPilot, the Performance Enhancement Packages 
(PEPs) are provided on a CD-ROM.

If you are using this procedure for a CallPilot system that is up and running, new 
PEPs are issued on the Nortel Networks CallPilot web site at 
http://www.nortelCallPilot.com.

Identifying the PEPs

The last character of the PEP name indicates the target platform for the PEP. For 
example, S indicates that the PEP is for the server.

Readme files

Readme files are provided in the following locations on the PEP CD-ROM:

■ the root directory on the PEP CD-ROM

This readme file provides a general description of the PEP packages and 
general PEP install and uninstall instructions.

■ in each PEP package folder

These readme files provide a list of all the PEPs in that package, and specific 
PEP install and uninstall instructions.

. 

CAUTION

Risk of system problems
For specific PEP installation instructions, refer to the readme 
files that are in the PEP CD-ROM root directory and in the folder 
for each PEP package. In many cases, PEPs must be uninstalled 
and installed in a specific order. The readme files provide these 
instructions. When the readme files instruct you to uninstall or 
install PEPs, refer to the procedures in this section.

ATTENTION
If your CallPilot system is up and running, Nortel Networks 
recommends that you perform a system backup before you 
install a new PEP. 

Refer to Monitoring and Security for the Administrator for more 
information on performing a backup.
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■ in each PEP folder

These readme files describe the purpose of that PEP and might provide some 
PEP installation instruction.

To install a PEP package

1 Ensure that you are logged on to the server on which you want to begin PEP 
installation. 

Use a logon account that has administrative privileges (for example, 
administrator).

2 Insert the CallPilot 1.07 PEP CD-ROM. 

3 Read the readme files that are in the PEP CD-ROM root directory and in the 
folder for each PEP package for specific uninstallation or installation 
instructions, or both.

4 Double-click runme.exe.

Result: Setup examines the system, and the PEPs to install window appears. 

Note: The following example is for illustration purposes only, and might not 
reflect what appears on your system:

ATTENTION
It can take 5 to 20 minutes for the PEPs to install window to 
appear, depending on the number of PEPs and the system 
configuration. In the meantime, a grey box might appear 
while the window is loading. Do not use the mouse or 
keyboard during this time.
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5 Select the PEPs to install, and then click Next. If you are uncertain about which 
PEPs to install, refer to the Readme file located in the root directory of the 
CD-ROM.

Result: The Nortel System Operations window appears and lists all 
components in the order in which they will be installed. 

6 Click Yes to continue.

Result: The system automatically shuts down all services, and the PEPs are 
installed. CallPilot automatically removes obsolete PEPs when you install new 
PEPs.

A summary similar to the following example appears showing the success or 
failure of each PEP operation. The PEPs displayed might be different for your 
server:

7 Click Yes to complete the procedure.

Result: The program ends.

8 Repeat this procedure for other PEP packages. A reboot is not required after 
installing PEPs unless Setup prompts you to reboot.
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What’s next?

IF you are THEN 

installing a new 
CallPilot system

run the Configuration Wizard (see Part 3 of this 
binder).

recovering from a 
hard drive failure

continue with the steps in “Recovering from a 
hard drive failure” on page 145.
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Uninstalling CallPilot server software

In this chapter
Uninstalling CallPilot 214
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Uninstalling CallPilot

Introduction

Uninstallation of CallPilot removes the software completely from the server. It also 
removes all CallPilot registry entries, linguistic information, and all links to 
CallPilot from the server database.  

Note: You cannot uninstall a specific language that has been installed. 

What is removed during uninstallation of CallPilot 

Uninstallation of CallPilot software removes the following files:

■ CallPilot entries in the Windows NT Registry

■ all CallPilot entries in the server database

Note: You cannot uninstall a specific language that has been installed. 

Before you begin

Obtain the current password for the Administrator account.

To uninstall CallPilot server software

Note: This procedure is valid for Fresh Installed, Upgraded, or Converted Systems.

1 To uninstall CallPilot, click Start > Programs > CallPilot > Uninstall.

2 Click Yes to confirm uninstall.

3 After CallPilot has been successfully uninstalled, click Yes to restart.

ATTENTION
Once you start the uninstallation process, you cannot restore 
CallPilot if you decide to cancel the process. You must 
perform a reinstallation to load CallPilot onto the server. 
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recovering 145–146
recovery requirements 145

failure codes, diagnostics 38
fault management

alarm notification 64
event processing 64

features, adding to CallPilot 136
field replaceable units 88
FRUs 88

G
General tab, Maintenance window 72, 73

H
hard drive

checking for shipping damage 21
failure

recovering 145–146
recovery requirements 145

removal 21
safety precautions

jarring 21
physical shock 21
storage 21
vibration 21

hard drive recovery
date and time, configuring 180
drivers, installing

SCSI device 186
tape drive 184

drivers, loading 165
dump file, disabling 183
erasing 154
network interface, configuring 166

Ethernet adapters 172
MS Internet Server 166
MS Loopback Adapter 171
network addresses 174
network bindings 176
Remote Access Service 169

NTFS partition, creating 160–164
overview 148–150
partition, formatting 156
partitioning 155
pcANYWHERE32, installing 190
ROM-DOS, booting 151

virtual memory, configuring 181
what you need 148
Windows NT, installing from 

CD-ROM 157–158
hardware

diagnostics, Windows NT 4.0 53
problems

detecting 66
isolating 67

HEX display
codes 33–34
location on 201i server 28

I
IDE hard drive

assembly diagram 121
diagrams

bracket, removing 125
removing 123, 124
screw locations 122

equipment needed for replacement 120
installing 125
LED 32
removing 122

installation log 50
installing

MPC-8 cards 133
the correct way 130

pcANYWHERE32 190
overview 190

Windows NT (hard drive recovery) 157–158
integrated diagnostics

running 86
troubleshooting failures 86

ipconfig command 56

L
languages, reinstalling 139
Last Result button 76
LEDs

IDE drive 32
location on 201i server 28
MPC slot 30

diagram 130
MPC slots

description 131
network 31
power status 29
SCSI device 32

logging on, Windows NT 159
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logs 55
Configuration Wizard 50
event

types 46
viewing 47

installation 50
upgrade 50

M
maintenance activities

hardware 14
overview 12
preparing for 15

Maintenance tab, Maintenance window 72, 74
Maintenance window

Diagnostics tab 72, 75
General tab 72, 73
Maintenance tab 72, 74
purpose 72
Replacement tab 72, 77
using 69

MAJ (fault status), what to do 41
MIN (fault status), what to do 41
MPC slot LEDs 30

description 131
diagram 130

MPC-8 cards
diagram 129
inserting correctly 130

diagram 133
installing 133
removing 131
supported versions 129

MPCs, caution 132

N
nbtstat command 60
netstat command 62
network interface, configuring 166

Ethernet adapters 172
MS Internet Server 166
MS Loopback Adapter 171
network addresses 174
network bindings 176
Remote Access Service 169

network LED 31
noncritical OS and switch diagnostics 37
NTFS partition, creating 160–164

O
OS and switch diagnostics, noncritical 37

codes 37

P
parts, obtaining replacement 17
pcANYWHERE32

configuring 201
installation overview 190
installing 190
patches, installing 200
setting as automatic service 204
starting (first time) 196
video mode, setting 198

PEP Maintenance (CallPilot system 
utility) 92, 95–96

Performance Enhancement Packages (PEPs)
identifying types 209
installing 210
overview 209
readme files 209
running a system backup 209
shutting down services 211

ping command 57
Power Down button 75
power status LED 29
Power Up button 75
precautions, safety

components 20
hard drive

checking for shipping damage 21
jarring 21
physical shock 21
storage 21
vibration 21

presentation format 18

R
recovering CallPilot

from a failed hard drive 145–146
from corrupted software 140–144
overview 138

recovery of hard drive
date and time, configuring 180
drivers, installing

SCSI device 186
tape drive 184
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drivers, loading 165
dump file, disabling 183
erasing 154
network interface, configuring 166

Ethernet adapters 172
MS Internet Server 166
MS Loopback Adapter 171
network addresses 174
network bindings 176
Remote Access Service 169

NTFS partition, creating 160–164
overview 148–150
partition, formatting 156
partitioning 155
pcANYWHERE32, installing 190
ROM-DOS, booting 151
virtual memory, configuring 181
what you need 148
Windows NT, installing from 

CD-ROM 157–158
reinstalling

corrupted software 140–144
languages 139

related documents, CallPilot Troubleshooting 
Reference 12

replacement parts, obtaining 17
Replacement tab, Maintenance window 72, 77
ROM-DOS

booting 151
description 151
hard drive

erasing 154
partition, formatting 156
partitioning 155

startup menu 152
Windows NT installation menu 153

Run button 76

S
safety precautions

components 20
discharging static 19
hard drive

checking for shipping damage 21
jarring 21
physical shock 21
storage 21
vibration 21

presentation format 18
SCSI device LED 32
security logs 55
server, 201i

and ACD Proxy 112

boot failure
8051, what to do 44
CallPilot, what to do 44

complete assembly diagram 118
components, equipment needed for 

replacement 116
date and time, configuring 180
drivers, installing

SCSI device 186
tape drive 184

drivers, loading 165
dump file, disabling 183
exploded view diagram 117
IDE hard drive

equipment needed for replacement 120
installing 125
removing 122

network interface, configuring 166
Ethernet adapters 172
MS Internet Server 166
MS Loopback Adapter 171
network addresses 174
network bindings 176
Remote Access Service 169

NTFS partition, creating 160–164
pcANYWHERE32, installing 190
removing from switch 113

what you need 113
replacing 114
ROM-DOS, starting 151
shutting down 112

what you need 112
software feature key

diagram 127
equipment needed for replacement 127
location on motherboard 127
replacing 127

virtual memory, configuring 181
Windows NT, installing from CD-ROM 

(hard drive recovery) 157–158
Services Monitor (CallPilot system

utility) 92, 97–98
Session Trace (CallPilot system 

utility) 92, 99–103
shutting down the 201i server 112
software feature key

diagram 127
equipment needed for replacement 127
location on motherboard 127
replacing 127

software maintenance 136
software, corrupted

recovery requirements 140
reinstalling 140–144

Start button 74
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button 75, 76
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system
event log, viewing 47
expansion, overview 14

System Information (CallPilot system 
utility) 92, 104

System Monitor (CallPilot system 
utility) 92, 105–107

system rebuild, overview 14

T
TCP/IP diagnostics 52, 56

arp 59
ipconfig 56
nbtstat 60
netstat 62
ping 57
tracert 58

tools you need 16
tracert command 58
troubleshooting

in CallPilot Troubleshooting Reference 12
in this guide 13
overview 12

U
uninstalling CallPilot 214

what is removed 214
upgrade log 50

utilities, CallPilot
accessing 92
Diagnostics Tool 93–94
PEP Maintenance 92, 95–96
Services Monitor 92, 97–98
Session Trace 92, 99–103
System Information 92, 104
System Monitor 92, 105–107

V
video mode, configuring for 

pcANYWHERE32 198
virtual memory, configuring 181

W
WARN (fault status), what to do 41
Windows NT

date and time, configuring 180
diagnostics 53–55
dump file, disabling 183
installing from CD-ROM (hard drive 

recovery) 157–158
logging on 159
system event log, viewing 47
virtual memory, configuring 181
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